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Return-To-Factory Warranty

Psion Teklogix warrants a return-to-factory warranty for a period of 90 days from
shipment or 120 days from shipment where Psion Teklogix installs the equipment.
The warranty on Psion Teklogix manufactured equipment does not extend to any
product that has been tampered with, altered, or repaired by any person other than an
employee of an authorized Psion Teklogix service organization. See Psion Teklogix
terms and conditions of sale for full details.

Service

When requesting service, please provide information concerning the nature of the
failure and the manner in which the equipment was used when the failure occurred.
Type, model, and serial number should also be provided. Before returning any
products to the factory, call the Customer Services Group for a Return
Authorization number.

Support Services

Psion Teklogix provides a complete range of product support services to its
customers. In North America, these services can be accessed through the Psion
Teklogix Helpdesk. The Helpdesk coordinates repairs and training, helps you to
troubleshoot problems over the phone and arranges for technicians or engineers to
come to your site. For contact information and a listing of worldwide offices, please
refer to Appendix A: “Support Services And Worldwide Offices”.

Disclaimer

Every effort has been made to make this material complete, accurate, and up-to-
date. Psion Teklogix Inc. reserves the right to make changes without notice and shall
not be responsible for any damages, including but not limited to consequential
damages, caused by reliance on the material presented, including but not limited to
typographical errors.
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APPROVALS AND SAFETY SUMMARY

Dectaration OF ConrORMITY
Product: netpad 1000 Series with Serial Docking Station

Application of Council Directives: EMC Directive: 89/336/EEC
Low Voltage Directive: 73/23/EEC

Conformity Declared to Standards: EN 55022: 1998; Class B;

EN 55024: 1998;
EN 61000-4-2; +4kV CD; +8kV AD
EN 61000-4-3; 3V/m, 80-1000 MHz, 900 MHz
EN 61000-4-4; +1kV Power lines
EN 61000-4-5; +2kV Common;

+1kV Differential mode

EN 61000-4-6; 3V, 150 kHz-80 MHz
EN 61000-4-11; AC Mains Ports

EN 61000-3-2; EN 61000-3-3

EN 60950: 1992 + A1 + A2 + A3+ A4 + All

Manufacturer: PSION TEKLOGIX INC.
2100 Meadowvale Blvd.
Mississauga, Ontario; Canada LSN 7J9
Year of Manufacture: 2002
Manufacturer’s Address in the
European Community: PSION TEKLOGIX S.A.
La Duranne; 135 Rue Rene Descartes
BP 421000

13591 Aix-En-Provence
Cedex 3; France

Type of Equipment: Information Technology Equipment
Equipment Class: Commercial and Light Industrial
Manufacturer: Psion Teklogix Inc. Ontario

Legal Representative in Europe: Psion Teklogix S.A. France
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Approvals And Safety Summary

Dectaration OF CoNFORMITY

Product:

Application of Council Directives:

Conformity Declared to Standards:

Manufacturer:

Year of Manufacture:

Manufacturer’s Address in the
European Community:

Type of Equipment:
Equipment Class:
Manufacturer:

Legal Representative in Europe:

netpad 3000 Series with Serial Docking Station

EMC Directive: 89/336/EEC
Low Voltage Directive: 73/23/EEC

EN 55022: 1998; Class B;
EN 55024: 1998;
EN 61000-4-2; +4kV CD; £8kV AD
EN 61000-4-3; 3V/m, 80-1000 MHz, 900 MHz
EN 61000-4-4; +1kV Power lines
EN 61000-4-5; +2kV Common;
+1kV Differential mode
EN 61000-4-6; 3Vgps, 150 kHz-80 MHz
EN 61000-4-11; AC Mains Ports
EN 61000-3-2; EN 61000-3-3
EN 60950: 1992 + A1 + A2 + A3+ A4 + All
EN 60825-1, AM.2: 2001; Laser Safety

PSION TEKLOGIX INC.
2100 Meadowvale Blvd.
Mississauga, Ontario; Canada LSN 7J9

2002

PSION TEKLOGIX S.A.

La Duranne; 135 Rue Rene Descartes
BP 421000

13591 Aix-En-Provence

Cedex 3; France

Information Technology Equipment
Commercial and Light Industrial
Psion Teklogix Inc. Ontario

Psion Teklogix S.A. France
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Approvals And Safety Summary

FCC INForMATION FOR THE USA

FCC Decuaration Or ConrormiTy (DoC)

Applicant’s Name & Address:

US Representative’s Name & Address:

Equipment Type/ Environment Use:
Trade Name / Model No.:

Year of Manufacture:

PSION TEKLOGIX

2100 Meadowvale Blvd.

Mississauga, Ontario, Canada L5N 7J9
Telephone No.: (905) 813-9900

Psion Teklogix Corp.

1810 Airport Exchange Blvd., Suite 500
Erlanger, Kentucky, 41018, USA
Telephone No.: (859) 371-6006

Computing Devices for Home and Office Use
netpad
2002

Standard(s) to which Conformity is Declared:

The netpad and Serial Docking Station, supplied by Psion Teklogix, has been tested and

found to comply with FCC PART 15, SUBPART B - UNINTENTIONAL RADIA-
TORS, CLASS B COMPUTING DEVICES FOR HOME & OFFICE USE.

Applicant:

Legal Representative in US:

Psion Teklogix Inc.
Mississauga, Ontario, Canada

Psion Teklogix Corp.
Erlanger, Kentucky, USA
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Approvals And Safety Summary

CE MARKING

When used in a residential, commercial or light industrial environment the prod-
uct and its approved UK and European peripherals fulfill all requirements for
CE marking.

R&TTE Directive 1999/5/EC

This equipment complies with the essential requirements of EU Directive
1999/5/EC (Declaration available: www.psionteklogix.com).

Cet équipement est conforme aux principales caractéristiques définies dans la
Directive européenne RTTE 1999/5/CE. (Déclaration disponible sur le site:
www.psionteklogix.com).

Die Gerite erfiillen die grundlegenden Anforderungen der RTTE-Richtlinie
(1999/5/EG). (Den Wortlaut der Richtlinie finden Sie unter:
www.psionteklogix.com).

Questa apparecchiatura & conforme ai requisiti essenziali della Direttiva Europea
R&TTE 1999/5/CE. (Dichiarazione disponibile sul sito: www.psionteklogix.com).

Este equipo cumple los requisitos principales de la Directiva 1995/5/CE de la UE,
“Equipos de Terminales de Radio y Telecomunicaciones”. (Declaracién disponible
en: www.psionteklogix.com).

Este equipamento cumpre os requisitos essenciais da Directiva 1999/5/CE do Parla-
mento Europeu e do Conselho (Directiva RTT). (Declarag¢do disponivel no
endereco: www.psionteklogix.com).

0O g&omMopdg avTo¢ TANPOL TIG PAGIKEG AT OELS TNG KOWVOTIKNG 00N Yiog
EU R&TTE 1999/5/EK. (H dMAwon coppodpemong datifetol ot
dtevBvvon: www.psionteklogix.com)

Deze apparatuur voldoet aan de noodzakelijke vereisten van EU-richtlijn betref-
fende radioapparatuur en telecommunicatie-eindapparatuur 199/5/EG. (verklaring
beschikbaar: www.psionteklogix.com).

Dette udstyr opfylder de Vasentlige krav i EU's direktiv 1999/5/EC om Radio- og
teleterminaludstyr. Erklering findes pa: www.psionteklogix.com).

Dette utstyret er i overensstemmelse med hovedkravene i R&TTE-direktivet
(1999/5/EC) fra EU. (Erkleering finnes pa: www.psionteklogix.com).

Psion Teklogix netpad EPOC User Manual



Approvals And Safety Summary

Utrustningen uppfyller kraven for EU-direktivet 1999/5/EC om ansluten teleutrust-
ning och dmsesidigt erkdnnande av utrustningens dverensstimmelse (R&TTE).
(Forklaringen finns att ldsa pa: www.psionteklogix.com).

Tama laite vastaa EU:n radio- ja telepditelaitedirektiivin (EU R&TTE Directive
1999/5/EC) vaatimuksia. (Julkilausuma nihtévilld osoitteessa:
www.psionteklogix.com).

(D Use of the 802.11 netpad in France:
Owing to French Government restrictions, the French 802.11 netpad is limited
to indoor use. They may be used outdoors, on private property, only with prior
authorisation from the French Ministry of Defense.

FCC INForMATION TO THE USER
RaDIO AND TELEVISION INTERFERENCE

This equipment radiates radio frequency energy and if not used properly - that is, in
strict accordance with the instructions in this manual — may cause interference to
radio communications and television reception.

It has been tested and found to comply with the limits for a Class B digital device
pursuant to part 15 of the FCC Rules. These limits are designed to provide reason-
able protection against harmful interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is encour-
aged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.
* Increase the separation distance between the equipment and the receiver.

* If you are using the equipment with a mains adaptor, plug it into an outlet
which is on a different circuit from that to which the receiver is connected.

*  Consult an experienced radio/TV technician for help.
For customers in the USA, the following booklet prepared by the Federal Commu-
nications Commission may be of help: “How to Identify and Resolve Radio-TV

Interference Problems”. This booklet is available from the US Government Printing
Office, Washington, DC 20402 - Stock No 004-000-00345-4.

Psion Teklogix netpad EPOC User Manual
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Approvals And Safety Summary

RADIO FREQUENCY EMISSIONS

Do not use in aircraft or hospitals. Some equipment in hospitals and aircraft are not
shielded from radio frequency energy. Do not use the netpad onboard aircraft, or in
hospitals, without first obtaining permission.

Do not use near pacemakers. The product may affect the operation of some medi-
cally implanted devices such as pacemakers, causing them to malfunction. Avoid
placing your product next to such devices. Keep a minimum distance of 15 cm
between the device and the product to reduce the risk of interference. If you have
any reason to suspect that interference is taking place, turn off the netpad and con-
tact your cardiologist for assistance.

@ Note: In August 1996 the Federal Communications Commission (FCC) of the

US adopted an updated safety standard for human exposure to radio fre-
quency energy emitted by FCC regulated transmitters. The design of this
product complies with the FCC guidelines and those standards.

To maintain compliance with the FCC RF exposure guidelines, if you
wear the netpad on your body, use the supplied or approved carrying
case, holster, or other body-worn accessory. If you do not use a body-
worn accessory, ensure the antenna is at least 1.5 cm from your body
when transmitting. Use of non-approved accessories may violate FCC RF
exposure guidelines.

A IMPORTANT SAFETY INSTRUCTIONS

Xiv

This equipment was tested for FCC compliance under conditions that included the
use of shielded cables and connectors between it and the peripherals. It is important
that you use shielded cable and connectors to reduce the possibility of causing radio
and television interference. Shielded cables, suitable for the netpad, can be obtained
from an authorised Psion Teklogix dealer.

If the user modifies the equipment or its peripherals in any way, and these modifica-
tions are not approved by Psion Teklogix, the FCC may withdraw the user’s right to
operate the equipment.

Psion Teklogix netpad EPOC User Manual



Approvals And Safety Summary

EmissioNs INFORMATION FOR CANADA

This Class B digital apparatus meets all requirements of the Canadian Interference-
Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Réglement
sur le matériel brouilleur du Canada.

INFRARED DEVICE SAFETY
Cuass | LED Probuct

This product includes an Infrared device for transmitting and receiving files from
devices supporting the IrDA format. Although this invisible beam is not considered
harmful, and complies with EN60825-1 (IEC825-1), we recommend the following
precautions when the Infrared device is transmitting:

* Do not stare into the Infrared beam.
* Do not view directly with optical instruments.

No parts in the device may be serviced by the user.

INTEGRATED SCANNER SAFETY

For your own safety, it is critical that you comply with the warnings described in
“The Scanner” on page 26.

BATTERY SAFETY PRECAUTIONS
CAuTiON!

Danger of explosion if a netpad battery is incorrectly handled, charged, disposed of
or replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Dispose of used batteries according to the instructions described in
“Lithium-Ion Battery Safety Precautions” on page 154. Carefully review all battery
safety issues listed in that section.

VorsicHT!

Explosiongefahr bei unsachgemidfem Austausch der Batterie Ersatz nur durch
denselben oder einen vom Hersteller empfohlenen gleichwertigen Typ. Entsorgung
gebrauchter Batterien nach Angaben des Herstellers.

Psion Teklogix netpad EPOC User Manual XV
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Chapter 1: Introduction
About This Manual

|.I About This Manual

This manual provides information on the operation and features of the Psion

Teklogix netpad. For additional information, refer to the netpad online help for the
application you are running, and to PsiWin online help, available on your PC when
PsiWin is installed. The manual references other user documents where applicable.

Chapter 1: Introduction
includes an overview of the manual, netpad applications, and instructions for
accessing the Help files.

Chapter 2: Getting Started
describes the netpad features, using the software, and directions on how to get
the netpad ready for use, including installation of battery, antenna and SIM card.

Chapter 3: Docking Station and MMC
details the docking station and multimedia card (MMC) slot (netpad-specific
hardware that supplies power, communications and removable storage).

Chapter 4: Using Infrared
describes data transfer and printing using netpad’s Infrared feature.

Chapter 5: Configuring The netpad
provides instructions on configuring the netpad’s security and Control Panel
features, and includes ways to customize your netpad.

Chapter 6: Files, Folders, and Programs
describes the netpad’s file manager and how to move around and manage the
information on your netpad.

Chapter 7: Connecting netpad To A PC
explains how to use PsiWin to copy files between a PC and netpad, and how to
synchronize files such as Agenda, Data and Contact files.

Chapter 8: Configuring Communications
instructs on the use of 802.11 radios, and the programs Opera (the Internet
browser), and Email (the e-mail, fax and SMS application.

Chapter 9: Printing With netpad
details the print capabilities of the netpad, which include printing via Infrared,
PC, and serial printers.

Chapter 10: Powering The netpad
provides important battery use and safety information.
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Text Conventions

Chapter 11: netpad Accessories
describes the accessories that are available for the netpad, including the
Charging solutions and In-vehicle Docking station.

Chapter 12: Troubleshooting netpad/PsiWin
assists in the recognition and correction of problems that you may encounter
when operating the netpad and PsiWin.

Appendix A: Support Services And Worldwide Offices
presents information for technical support, contacts and the Psion Teklogix
worldwide web address.

|.2 Text Conventions
@ Note: Notes highlight additional helpful information.

A Important:  These statements provide particularly important instructions or

additional information that is critical to the operation of the
computer and other equipment.

&% Warning: These statements provide important information that may prevent

injury, damage to the equipment, or loss of data.

|3 Applications Installed On The netpad

The netpad is capable of running a wide variety of applications but the ones
available on your particular netpad depend on the purpose for which the netpad is
provided. A number of standard applications exist and custom programs can be
installed easily.

The following standard programs are available:

Word, a word processor for writing letters and other documents.
Sheet, for spreadsheets, tables, and graphs.

Contacts, an address book.

Agenda, a diary program for appointments and lists of things to do.

Email, for sending and receiving e-mail, SMS and fax messages.
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*  Opera, for browsing the World Wide Web.
* (Calc, a calculator with general and scientific features.
* Jotter, a notebook for jotting down ideas quickly.

* Time, for alarms and a world map with international times and
dialling codes.

* Data, a customisable database program.
*  Sketch, for drawing pictures.
* Record, for recording and editing voice memos and sounds.

*  Program, the editor in which you can create programs using the built-in
programming language.

e  Spell, for checking spelling, thesaurus, solving anagrams and
crossword clues.

¢ Comms, for terminal emulation and file transfer.

|4 Displaying Help
You can display Help at any time from the standard netpad programs including the
System screen. Help information is contained on a series of “Help cards”. Help is

specific to the program that you are using; wherever you are, you can just type a
“clue” to search for the information you need.

@ Note: The online help contains more detailed information than is included in
this manual.

To display Help:
Select the Help command from the Tools menu. In the System screen, general
help on the netpad is also available.

To search for help about something:
type your clue into the Find: box, and press Enter. If the Quick find button is
selected from the Toolbar, the display will show a list of Help cards with the
clue in the title or initial description. Alternatively, if the Find in all button is
selected, the display will list all cards with the clue in the text. To move between
cards, tap on the Prev or Next buttons, press Enter, or use the left and right
arrow keys.
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To look through the help text:
drag the scroll bar on the side of the Help card, or tap the up and down
arrow keys.

To print the current Help card:
tap the Print button on the Toolbar or select Print from the File menu.

To type in another search word: press Esc, and then type in the word to search for
as before. To use one of the last five search words again, tap on the button next
to the Find: box, or press Tab and select the word you want to use.

To return to the program you were using:
tap the Go back button on the Toolbar, or tap the program’s icon.

@ Note: You can highlight text in a Help card using the stylus or keyboard, and
copy it to use in a file of your own. Copy the text by selecting the Copy
command from the Edit menu. Then go to your own file, and paste it in.

/Text Found By Search Help }opics In Card Browser

Systemy? Quick start _| | ® Systern: Quick start % Help
The Syg¥emn screen is the netpad's file and = Extras: Quick start = ﬁ'é 2‘,.'.,”"
» manager, displaying the files on the Program: Quick start g e
, and the folders that are used to Browsing folders & files| — || "7 al tex

organise the files,

Use the Systern screen to: Closing files & program @;Pﬁm
Combining files in Progi

* Open and close files and programs. = A
- Creating a file " Goback

* Create new files and folders. .
= Faxing from other progr _'_\
* (Change the way files and folders are v - - A,
il o File & folder names A N
Find: proaram . @ \ 16| Formatting text (Progral s || 5. 70 Go Back
\ Without
Search Clue Help On Topic Card Closing Help
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.5 Caring For The netpad

When used according to the instructions in this manual, the netpad should remain in
good working order for many years. However, there are certain precautions you
should take to ensure continued trouble-free use:

Do operate the netpad within temperature limits of -20°C to +60°C (-20°C
to +55°C for scanner variants), and store when not being used within tem-
perature limits of -25°C to +70°C (-25°C to +60°C for scanner variants). To
maximize long term battery life, where possible operate and store the
product within temperature limits of +10°C to +35°C. Avoid sudden
changes in temperature, exposure to direct sunlight and heat sources (elec-
tric heaters, etc.)

Do keep the netpad away from strong magnetic fields (e.g. loudspeakers)
and sources of static electricity.

Use only the Psion Teklogix-approved docking station.

Do back up regularly. You can use PsiWin to back up your netpad to your
PC, or you can make backups to a multimedia card. See “Things To Do
Next” on page 54 for more information.

To clean the screen: switch the netpad off and use a soft, clean, dry cloth to
gently wipe the keyboard and screen. (If the netpad is set to turn on auto-

matically when you open the case or tap the screen, you should turn this

preference off before cleaning the screen.)

A Important:  Under no circumstances use chemical solvents that may have a

corrosive effect.

Do not tap the screen with any object that has a sharp tip or you may
damage the screen. Don't use any type of ink pen, as the ink may be impos-
sible to remove. When not in use, keep the stylus supplied with the netpad
in its storage compartment.

Do not throw, or try to bend the netpad. (The netpad is designed to with-
stand a 5ft drop onto any surface.)

Do not keep the netpad next to credit cards or transport tickets; the speaker
magnet could corrupt the information on the magnetic strip.

Do not attempt to dismantle the netpad. There are no user-serviceable parts
inside and any attempt to do so will render the warranty void.
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* Do not remove the main battery for longer than necessary. The backup
battery maintains the netpad’s memory for some hours; however, prolonged
reliance on the backup battery does reduce its life.

Important:  If both the batteries run out of power you will lose all your infor-
mation on the internal disk.

|.6 Additional Programs And Third Party Applications

Psion Teklogix has partnered with a number of companies to provide a suite of con-
nectivity and database tools for the netpad. Below is a list of the partners and their
applications. More details are available on the Psion Teklogix Partner Program web
site at: http://partners.psionteklogix.com/partners/.

Afaria

Afaria (from XcelleNet) helps you exploit your existing IT resources by providing a
cost-effective and reliable way to manage your mobile devices.

Easy to install and integrate into your current infrastructure, Afaria lets you quickly
implement systems management for mobile devices to reap the benefits of greater

efficiency, increased productivity, and improved user satisfaction. In addition, your
users enjoy improved service levels, hands-free maintenance and shorter connection
times required to access important corporate information from their mobile devices.

AirZip
AirZip Accelerator provides plug-and-play performance enhancement for deliver-

ing images—diagrams, CAD drawings, photos, scanned documents—quickly and
easily to mobile devices.

*  AirZip Accelerator transparently boosts download speeds by 300-500%,
and reduces device memory storage requirements by up to 80%.

* AirZip Accelerator makes it possible to include mission-critical images and
graphics as part of Psion Teklogix solutions, dramatically improving end
user productivity, and overall solution ROL.

e AirZip Accelerator works with any web application or content, and all
Psion Teklogix EPOC or WinCE devices.
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Broadbeam

Broadbeam Corporation is a proven wireless platform provider that offers the
industry-leading Axio™ platform, SystemsGO!™ wireless managed services, and
Professional Services that allow customers to rapidly create, deploy and manage
wireless applications.

Headquartered in Princeton, NJ, Broadbeam has multiple offices throughout the
United States, Japan and the United Kingdom, and serves over 500 customers on six
continents.

(I

InkTools™ is a high performance software developers kit for implementing
systems using electronic ink or handwritten signatures. The toolkit enables applica-
tion developers to create eSign compliant software. InkTools™ provides electronic
ink capture and display, signature verification, encryption and ink compression as
well as other algorithms that can add competitive and performance value to a wide
variety of vertical applications as well as document and transaction based applica-
tions. Developers use InkTools™ to add electronic handwritten signature and secu-
rity features to enterprise applications deployed on mobile platforms.

Citrix

Psion Teklogix and Citrix are pleased to be able to announce the availability of the
Citrix ICA client running on Psion Teklogix devices supporting the EPOC platform.
This gives Psion Teklogix and Citrix solution providers the opportunity to provide
solutions that can deploy a wide range of traditional back office solutions onto most
of the devices in the Psion Teklogix range.

Eliad

Eliad Technologies, Inc. provides Java™ small footprint display technology for
advanced interfaces on multiple platforms. Eliad works with market leaders to
define tomorrow’s architecture for mobile computing. Eliad offers include two fam-
ilies of products:

e XML-Run™ : XML/Java GUI technology for mobile applications.

e JSmartGrid™: Advanced Lightweight and powerful Java™ Swing
component.
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Ericom

PowerTerm WebConnect is a comprehensive platform-independent, Java-based
web-to-host connectivity solution for Psion Teklogix mobile computers, desktop
PCs and many thin client and PDA devices. PowerTerm WebConnect provides a
robust connection to a wide variety of hosts including IBM Mainframe, IBM
AS/400, Unix, Tandem, VAX/VMS, Alpha/OpenVMS, Hewlett Packard, SCO,
Data General and others.

Extended Systems

XTNDConnect Server is server-based synchronization and device management
software from Extended Systems that allows information to be transferred directly
between corporate applications and mobile devices without understanding IT con-
cerns associated with corporate standards, security, data encryption or support costs.

FieldWorker

FieldWorker is a Rapid Mobile Application Development Utility written in Java
that has allowed FieldWorker, our resellers and our customers, to create over a
hundred mobile applications for a wide variety of different vertical applications.
FieldWorker is designed to be handheld PC independent, operating system indepen-
dent, communications infrastructure independent and even language independent.
FieldWorker is designed to capture and exchange data with almost any ODBC SQL
compliant databases using docking cradles, wired and wireless LANs and WANSs,
and even browsers on the Internet.

IBM DB2 Everyplace

IBM’s DB2 Everyplace is a small footprint relational database and synchronization
server designed to extend enterprise computing to mobile devices. DB2 Everyplace
is being used by application developers, systems integrators and enterprises around
the world to enable enterprise applications to be used on mobile devices. The DB2

Everyplace solution has the following key components:

* The DB2 Everyplace database on the mobile device is a small footprint,
robust, relational database.

* The SQL statements supported by DB2 Everyplace allow you to create or
drop a table or index, and delete, insert, or update rows of a table. The DB2
Everyplace database supports the following mobile platforms: EPOC,
Palm, WinCE/Pocket PC, embedded Linux and the desktop platforms of
Win32 and Linux.
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IBM MQSeries Everyplace

IBM MQSeries Everyplace extends the IT infrastructure to include dependable
and secure communications with mobile workers into what was a failure-prone
environment, allowing them to access corporate data and applications on any of the
35 platforms in an MQSeries network. It connects laptops, PDAs and phones, and
unattended devices such as servers, sensors and probes. It includes rich extensible
security options and can easily work through firewalls. MQSeries Everyplace
allows mobile workers do their work anyplace, anytime, anywhere—safe in the
knowledge that their message will get through.

Impatica

Impatica technology enables Microsoft PowerPoint™ presentations to be viewed
on the EPOC OS by quickly converting the presentation into a Java applet that can
be viewed with the mobile computer’s web browser. The ‘impaticised’ presentation
can either be stored and accessed locally on the device, or run over the Internet.
Impatica enables interactive rich media content on the netpad.

Informix

A high performance, function-rich SQL database for Java applications along with
synchronization technology that allows data to be shared with enterprise database
servers (Informix, DB2, Oracle etc.). Informix Cloudscape is a platform that com-
prises three major elements:

*  Cloudscape - A small footprint, 100% Pure Java™, object-relational data-
base management system.

¢ Cloudsync - An innovative way to maintain agreement between central
applications and distributed applications that may only be occasionally con-
nected to the Internet.

¢ Cloudconnector - A server framework that supports connection pooling,
remote JDBC, HTTP, and HTTPS connections from an application to a
Cloudscape database.
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KI

Mobilelntegrator from Ki is a rapid application development tool that has been
used to write applications as simple as a questionnaire of a few lines, and as
complex as complete support for medical rounds or anamnesis with tens of thou-
sands of data entry fields structured in hierarchical trees. By using the XML-format
for the internal representation of the input dialogues as well as the captured data, the
resulting applications are flexible enough to be very easily integrated into existing
system environments.

Oracle

Psion Teklogix and Oracle Corporation are pleased to announce availability of
Oracle 8i Lite for Psion Teklogix devices. Oracle 8i Lite, the Internet platform for
mobile computing, is a complete platform for developing, deploying, and managing
mobile applications. Oracle 8i Lite comprises two elements: Oracle Lite DBMS,
Consolidator and Web-to-go.

Palmware

MPS is a virtual computer universal interface eliminating the differences between
platforms (hardware and software) offered by IT and telecommunications vendors.
MPS works in a complementary way with the machine’s native operating system,
and it is designed for mobile platforms. MPS guarantees the use of a standard appli-
cation across a wide variety of platforms. What this means to developers is that
MPS offers a single development environment, irrespective of the varying OS
requirements that may otherwise be made by a diverse range of target systems while
being able to retain their individual capabilities and performance characteristics.

Sybase

SQL Anywhere Studio is a suite of products for database development and data
synchronization. The suite includes a full database development environment
(Adaptive Server Anywhere) and a small fingerprint database designed for small
devices. The components of the product suite are:

*  UltraLite deployment technology for Adaptive Server Anywhere generates
an application optimized database targeting memory constrained devices.

*  MobiLink synchronization technology provides for the secure, bidirectional
exchange of enterprise information between remote devices and heteroge-
neous data sources including Sybase, Oracle, Microsoft, and IBM.
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Tao

Tao’s Intent® provides application developers with the ability to run compliant
Personal Java applications very fast and in addition exploit a rich set of Multimedia
features to complement those AWT functions associated with the Java Virtual
Machine. Intent® enables Java applications to run on the netpad extremely fast,
making the deployment of Java applications for enterprise client devices a reality, as
well as providing a platform to run compelling content.
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2.1 Features Of The netpad

This netpad is an EPOC-based mobile tablet computer with a 1/2 VGA touchsensi-
tive screen. netpad is lightweight, shock and water-resistant, and designed for use in
a wide range of business areas including field service, field sales, transport, health
care, hospitality, manufacturing and insurance. It is available in variants with inter-
nal 802.11B radios and scanners.

---- Touch Screen Display

AT
Button /&

Programmable
Function Keys

Microphone

Programmable
Function Keys

L2 RS232 Port

Figure 2.1 netpad Front

. Docking Station
Charging Contacts

Stylus

Figure 2.2 Back Of netpad
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Scanner Window ---i

LASER RADIATION
CLASS 3 LASER PRODUCT (IEC) TEKLOGIX

CLASS II LASER PRODUCT (CDRH)| SEE BATTERY COMPARTMENT

650 nm LASER DIODE
1.2 MILLIWATT MAX OUTPUT FOR MANUFACTURING DATA
DIN EN 60825-1: JANUARY 2001 netpad 3500

Figure 2.3 Location Of Scanner

2.2 Preparing The netpad For Use
2.2.1 Power

22.1.1'  Power Management

The netpad is powered by a powerful Lithium Ion rechargeable battery pack, which
under normal operating conditions will provide power for up to 8 hours use. The
netpad will warn you when the main battery charge is low. For complete details
about battery safety, and details of how to change the main battery, see Chapter
10: “Powering The netpad”.

@ Note: You can also power the netpad from the mains by placing it in the
docking station (see page 39).

To charge the battery, place the complete netpad in a netpad docking station (for
instructions, please refer to page 39), or place the battery in one of the optional
battery chargers. The standard (850 mAH) netpad battery will normally be fully
charged within 2 to 2.5 hours (3 hours for a 1400 mAH battery pack).
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An internal, rechargeable backup battery allows you to replace the battery pack at
any time without loss of data, applications or resetting to the default settings. The
backup battery maintains the netpad’s memory for some hours, however prolonged
reliance on the backup battery does reduce its lifetime.

Important:  If both the batteries run out of power you will lose all your infor-
mation on the internal disk.

You can take steps to help prolong your battery’s life:
e Turn the screen brightness down.

*  Set the automatic switch-off in the Power control panel, to automatically
turn the netpad off after a convenient time.

*  Use files on the internal disk instead of an MMC, as the netpad requires
more power to write to the mulitmedia card.

2212 fFitting The Battery

Before you can use the netpad you must fit the battery - slide it into place until it
clicks as shown in Figure 2.4.

Important:  Always switch off the netpad before removing the main battery.

---- Battery Contact Pins

;- Battery Pack

Direction of
Insertion

Figure 2.4 Battery Insertion
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ﬁ Important:  Take care when replacing batteries!

The netpad will warn you when its main battery is getting low, in
plenty of time to change/charge it. The backup battery is designed
to maintain the memory for several hours; however, prolonged reli-
ance on the backup battery does reduce its life.

2.2.2 Hitting The Antenna

Before using netpad units fitted with 802.11 radios, the antenna must be installed.
The antenna should be installed as shown in Figure 2.5 below. To install the antenna
turn it counter clockwise; to remove the antenna turn it clockwise.

Figure 2.5 Antenna Insertion And Removal

2.2.3 Installing The SIM Card

A netpad fitted with a GSM/GPRS radio requires a Subscriber Identity Module
(SIM) card installed in order for the netpad to access the GSM network. The SIM
card fits into a dedicated slot in the netpad. The SIM card slot compartment is
located behind the Card Slot door on the side of the netpad; the SIM card slot is
located below the Multimedia card (MMC) slot (see Figure 2.7 on page 22).

A Important:  The MMC slot and SIM slot are located very close together. When
inserting or removing the SIM card be careful not to drop the SIM

card into MMC slot.
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To insert the SIM card:

*  Open the card slot door located on the side of the unit by sliding the retain-
ing latch.

*  Push the SIM card into place until it is fully inserted. Note the orientation of
the card, shown in Figure 2.6 on page 22, with the notch of the card on the
left, trailing side. The cross-hatching on the card will be facing down.

¢ Close the door.

A Important:  Ensure that the SIM card is inserted in the correct orientation as
shown. Once inserted, the SIM card can only removed using a pair of
tweezers or long-nosed pliers.

If the SIM card is inserted incorrectly, the unit will not connect to the
GSM network. If the SIM is inserted incorrectly, it must be removed
by following the instructions given below.

To remove the SIM card:

*  Open the card slot door and grasp the card on the cross-hatch area (see
Figure 2.8 on page 22), using the special removal tool supplied or a pair of
tweezers or long-nosed pliers. Pull the card out carefully.

Warning: To prevent damage to the SIM, ensure that the netpad is switched
off and the battery removed before removing the SIM card.

Orientation of Card
(notched corner)

Psion Teklogix netpad EPOC User Manual
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Figure 2.6 Insertion Of SIM Card

Orientation of netpad
(screen side up)
HR J

MMC

SIM Card

Card Slot Door

Cross-hatched Area of SIM Card
(grip here with pliers)

Orientation of netpad
(screen side down)

Figure 2.8 Removal Of SIM
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2.3 Turning On And Off

To switch on:
press the On/Off button. When you first do this, you’ll see the System screen.

@ Note: The netpad will automatically switch on when an alarm rings.

To switch off:
press the On/Off button on the top. You can switch off at any time. You do not
have to save your information first, as it is automatically saved for you.

@ Note: If you do not use the netpad, it will automatically switch off after 5 min-
utes to save battery power. Switch it on again, and you can continue from
where you left off. (The time for automatic switch off can be modified via
the Control Panel - see page 56.)

2.4 Finding And Using The Stylus

The stylus is located in a holder at the right. To remove it, slide the stylus out of the
top of the netpad. To replace it, push it back in.

Tap lightly on the screen using the stylus. It’s OK to use your fingers to tap on the
screen, though it is best to use the stylus to avoid fingerprints or smudges on the
screen. Do not tap the screen with any object that has a sharp tip or you may damage
the screen. Don’t use any type of ink pen, as the ink may be impossible to remove.
See “Caring For The netpad” on page 7 for instructions on how to clean the screen.

You can usually tap on an item with the stylus to select or change it. For example,
you can tap on:

e the program icons, to open a program.

* the command icons, for “shortcuts” to System functions, e.g. the menu bar,
cutting and pasting, Infrared, zooming in and out.

@ Note: If the screen doesn'’t respond to your taps, you may need to re-calibrate it.
You can do this by opening the Screen icon from the Control Panel.
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2.5 The Screen, Command Icons And Toolbar
The netpad has a column of permanent “command icons” on the right-hand side.
From top to bottom these are:

Menu: _
Displays the menus for the current program. Menus are displayed
along the top of the screen.

Contrast and brightness control: Ny
Tap the icon repeatedly to cycle through the default brightness levels. -Q:}

Zoom control: —
Tap the icon repeatedly to cycle through the zoom settings. The zoom
settings depend on the application you are in and are stored indepen- Q
dently for each application. S

Keyboard: %
Displays the Psiboard, the on-screen keyboard.

System command icon:
When you are in a program, the System command icon displays the @
System screen. From the System screen, tapping the icon displays the
Program bar containing the icons for the programs installed on your
netpad.

When you are in a program, the program’s Toolbar is usually displayed to the left of
the command icons. This Toolbar contains four icons with the name of the program
above them. Tapping on the name displays the list of open files and folders. Below
the name are four icons that vary from program to program and are the most com-
monly used functions for each program.

A Important:  Battery life is considerably reduced when the brightness
is increased.
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2.6 How To Reset The netpad

If you find that you cannot exit a program normally, move to the System screen and
select the List open files command from the File menu. Select the program from the
list and press the Close file button.

If this does not work, or if your netpad appears to have “locked up”, you can always
perform a “soft reset”. This should restart your netpad while preserving most of
your information.

It is worth trying a soft reset if the keys on the netpad do not appear to respond,

or if the netpad appears to switch on and you are sure that the batteries are good
(especially if the contrast adjustment still appears to work), but the screen is other-
wise blank.

To perform a soft reset:
gently press the stylus onto the reset button. This is located inside the MMC
door cover to the side of the MMC slot.

After a soft reset, any changes to open files (such as Word or Sheet files) will be lost.
Your other files on the Internal disk will almost always be safe.

It is possible (although unlikely) that a program failure causes the reset to lose the
information on the Internal disk; it could even prevent the reset from working at all.
If this happens, you will have to perform a “hard reset”.

To perform a hard reset:
1. Remove the netpad from the docking station.
2. Remove the main battery.
3. Press and hold down the On/Off button (on the top of the unit).
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4. While continuing to hold down the On/Off button, press and release the
Reset button.
5. Release the On/Off button.

A Important: A hard reset resets the netpad completely, and all information on
the Internal disk will be lost.

_ Docking Station
Charging Contacts

2.1 The Scanner

Where fitted with a bar code scanner, the netpad may be used to read industry
standard bar codes.

To scan a bar code, point the scanner window at the bar code, ensuring that the
scanner window is not obstructed and that you are between 5 cm (2 in) and 60 cm
(24 in) from the bar code. Activate the scanner as instructed in the software applica-
tion’s operating instructions. The scanning beam should be energized until a
successful decode is achieved or three seconds have elapsed.
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Scanner Window ---i

LASER RADIATION
CLASS 3 LASER PRODUCT (IEC) TEKLOGIX

CLASS II LASER PRODUCT (CDRH)|

SEE BATTERY COMPARTMENT

650 nm LASER DIODE
1.2 MILLIWATT MAX OUTPUT FOR MANUFACTURING DATA
DIN EN 60825-1: JANUARY 2001 netpad 3500

‘%é Warning:

For your own safety, it is critical that you comply with the
Jfollowing warnings:

1. Do not look into the scanner window.

2. This product contains a laser scanner that emits less than 1.2 mW
average radiant power at a wavelength of 650 nm. This product
complies with 21 CFR 1040.10, 1040.11 and DIN EN 60825-1:
January 2001, and is classified as a Class 2 laser product.

3. CAUTION - Using controls or adjustments, or performing proce-
dures other than those specified herein may result in hazardous
radiation exposure.

4. CAUTION - The use of optical instruments with this product will
increase eye hazard.
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2.8 First Steps

When you first switch on the netpad, you will see the System screen. This is the
“desktop” where you can view your files and folders, and change settings that
control how the netpad works.

e All the information you enter into the netpad is contained in files; their
names are displayed in the System screen, beside icons that represent the
programs that created them.

* All your files are stored in folders. When you start using the netpad, the
contents of the Documents folder is displayed.

* The System screen’s Title bar shows you which folder is currently dis-
played on the screen. When you start, you are in the Documents folder on
the C (Internal) drive.

You can have as many folders as you wish, and create folders within other folders.
Folders can contain files created in a variety of programs; they are not restricted to
files from a single program. See Chapter 6: “Files, Folders, and Programs” for
details of managing files and folders.

2.8.1 Aligning The Touch Screen

You can ensure that the touch screen is properly calibrated using the Screen menu.

1. In the System screen, tap on Control Panel on the Toolbar, or select the
command from the 7ools menu.

2. Tap the Screen icon.

3. The Screen settings dialogue comes up. Tap the Calibrate button at
the side of the page, then follow the instructions on the screen. You will
be asked to tap the centre of each point indicated on the screen. At the
conclusion of the test, the calibration will be completed when you
accept the new settings by tapping on the Yes button.
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2.8.2 Navigating Between Files And Folders

e Tap on a folder icon to move to that folder, tap on the Close folder icon to
close it and move back up a level.

» Tap on afile to select it, tap again to open it. If the file name is displayed in
bold, the file is open, and tapping it will move straight to the file.

See Chapter 6: “Files, Folders, and Programs” for more information about manipu-
lating files and folders.

Folder
[3 v E— Toolbar
Title B o
t
itle Bar ; 3
Current Folder 3 <, <&— Command
8 @ Icon Bar
<)

2.8.3 Starting Programs

When you open or move to a file, the correct program for this file is started automat-
ically. You can also start programs by tapping on the appropriate program icon.

* If necessary, tap the System icon @ at any time to move to the
System screen.

* Tap on it again to display the Program icon bar, which contains more
program icons.

You don’t have to close one program before opening another, just tap on another
program icon, and that program will open too.

You can see what files and programs are open from the System screen by using the
List open files command from the File menu, or by tapping on the name in the top
right corner of the screen.

Open files / programs

System
Sheet C:iDocumentsiSheet
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2.8.4 Programs And Files

When you run a program, it will usually display the currently open file, or the file
that you last looked at. If you want to write a new letter, draw a new picture,
create a new database and so on, you’ll need to create a new file for the particular
program involved.

To create a new file:
select the Create new file command on the File menu and type in the name for
the new file (see “Entering Information”, below). The file will now be created,
and the current file will be closed and saved at the same time. You can start
entering your information.

You can also use this command in the System screen to create a new file. Usually,
this creates a file using the standard settings; creating a file from within a program
creates a file that already has any settings or preferences you have set up in

the program.

It is a good idea to keep related files together in a folder, to make the files easier to
find later. See Chapter 6: “Files, Folders, and Programs” for details of how to
manage your files and folders.

2.8.5 Entering Information

You can enter information and complete tasks using the stylus or the Psiboard. The
Psiboard is displayed by tapping the Keyboard command icon.

E=11 |2 |3 (4|56 |7 8|90 |- |=|+—

Melg lwielr |t |¥yluli [o|p|[ ]
Cmasdfghjkl;'#|‘J

4V jzxle v blnim|, |[. | |*]| & 3
= == 2= /Slzmg Corner
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You can:
*  Move the keyboard by tapping the title bar and dragging it.
* Resize the keyboard by dragging the bottom right-hand corner.

*  Minimize the keyboard by tapping the underline symbol on the top right-
hand corner of the keyboard.

Psiboard [H EX

*  Maximize the keyboard again when you need to type something, by tapping
the underline symbol.

Tap the P symbol to display and set the keyboard preferences; for example if you’re
using a program such as Word in which you need to type a lot of text, you may want
to set ‘Always on top’ to prevent the Psiboard from disappearing every time you tap
on another part of the screen. Then, to move the Psiboard out of the way,

minimize it.

Preferences

4 Qwerty >
Key Font Arial
Always on top 4
Sound Off@ Click(> Beep(
Launch with Qwerty

|Cancel| | OK I

When you are in a dialogue in which you need to enter information, Psiboard is dis-
played in a different mode. When you tap twice in a line, the keyboard opens. As
you type the text is shown. When you tap Done, the keyboard closes and the line of
text is entered in to the dialogue. You can use the Next and Prev buttons to move
between items on the dialogue.
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Psiboard is the netpad’s default keyboard. If you load a different keyboard
you can use this instead. In the Control Panel, select the Text input icon,
and select the new application from the list.

2.8.6 Using Menus

You can usually select a menu command to perform each task.

@ Note:

e
Press the Menu key on the Psiboard or tap on the |: command icon to see
the available commands on the Menu bar.

Tap on the menu names and commands, or use the arrow keys to move
around the menus. Tap on commands marked with a } or press the right
arrow key to see further commands.

You can press the shortcut key combinations shown next to the commands
as a quick way of selecting them, e.g. Ctrl+M, means hold down the Ctrl
key and press the M key at the same time.

A menu command with three dots at the end means that selecting the command will
display a “dialogue” where you enter more information.

If a menu command is grey, it means that it’s not currently available; e.g. you cannot
Copy unless you have first selected something to copy.

2.8.7 Using Dialogues

A “dialogue” appears when you need to make selections and enter further informa-
tion. You can move between dialogue items by tapping on them, or using the up and
down arrow keys. Dialogues contain one or more of the following elements:
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Textbox:
where you just type in your information. When you tap in the textbox, Psiboard
opens SO you can type in.

Listbox:
where you select from a number of options. You will see left and right arrows
around the current selection; you can change the selection by tapping on the
arrows, by pressing the left and right arrow keys, or by typing the first letter of
the option you want. You can usually tap in the box or press the Tab key to see a
list of the available options.

Checkbox:
where you make a choice between selecting an option or not selecting it. Just
tap on the checkbox, or press the left and right arrow keys to add or remove
a check.

Radio buttons:
where you make one choice from a number of options. Just tap on an option, or
use the left and right arrow keys to make a selection.

If a dialogue line is grey, it is currently not available, usually because you have to
select something else first. For example, if you have not checked the box to set an
alarm for an Agenda entry, the lines to set the alarm time and date are grey. Some
dialogue lines only appear when another option has been chosen.

Some dialogues comprise a number of “pages”, each page has a “tab” at the top. Tap
on the tab, or move the highlight to the tab name, to go to that page. You can also
move a dialogue around the screen by holding the stylus on the dialogue title bar and
dragging it across the screen.

Dialogue Page Radio Button
N

Clock type Analoga Digital
Titne format 12 hria 24 hr
amipm format 1:23 am

Listbox
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28.1.1  Dialogue Buttons

Dialogues may have on-screen buttons. Tap on the button. Some buttons have a
standard keypress equivalent:

e Usually, you can tap the OK button or press the Enter key if you want to
save information and remove the dialogue.

*  Tap the Cancel button or press the Esc key if you want to remove the dia-
logue without saving the information.

* For dialogues that ask a question, you can tap the Yes button or press the Y
key for ‘yes’; tap the No button, press the N key, or press the Esc key for ‘no’.

2872 How To Display A Calendar

In most dialogues in which you can type a date, move to the date line then tap again
or press Tab to display a calendar.

Today’s date is circled, and the date currently displayed in the dialogue is high-
lighted. To select another date, move to the date you want and press Enter. Use the
buttons on the top line, or further presses of the Tab key, to display a three month or
twelve month calendar. Use the “dog ears” to move between the pages of the calendar.

You can also display a calendar from the Agenda program. See the Agenda docu-
ment for more details.

2.8.8 Copying Information Between Programs

You can insert information created in one program into a different program. This is
known as “inserting” an “object”.

For example, you may want to add a picture to a letter you are writing. To do this,
write the letter as normal, for example using the Word program. Then, while in
Word, tap the Insert sketch button on the Toolbar or select the command from the
Insert menu. This will start the Sketch program (if it is installed), where you can
create the picture. Close Sketch when you have finished and the picture will be
inserted into your letter.

Sometimes the object you insert can be displayed as an icon, for example, if you
insert a large amount of Word text into an Agenda entry. (Agenda is netpad’s stan-
dard calendar program.) Alternatively, you may prefer to see the actual information
added, e.g. a map to view in the Word file.
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For example, you may wish to:

L]

insert tables of figures and graphs from a spreadsheet such as Sheet into a
Word file. You can add labels and titles to the graph in Sheet before insert-
ing it in the Word file.

keep a map of how to find a restaurant as a sketch, perhaps attached to an
Agenda entry for the day that you’re going there.

create a Sketch file of your signature, and insert the signature when you
write letters in the Word processor.

keep handwritten notes and ideas in Sketch. You can then insert them into
the Jotter notepad program or a Word file if necessary.
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Using The Docking Station And An MMC

3.1 Using The Docking Station And An MMC

This chapter describes the netpad-specific hardware—the docking station and multi-
media card (MMC) slot. The docking station is used as a convenient “drop-in”
holder for the netpad, supplying power and communications through the docking
station connector, rather than through separate cables.

The MMC slot provides removable storage and allows the netpad to expand its data
and application storage capabilities.

3.1.1" Docking Station

The netpad docking station provides a permanently connected holder for the netpad.
The power jack is on the front and the serial communication sockets are situated at

the right of the docking station. The connector to the netpad faces upwards from the
middle of the station. This connector mates with the connector on the underside of

the netpad, and provides both power and serial communications.

Place the netpad in the docking station and it will begin charging.

:-- Release Button

- IR Ports
P ---- netpad Connectors -~ Communication
: Ports

,,,,,,,,, Yellow LED indicates
communications

t- Red LED indicates charging/
Green LED indicates charged

L Red LED indicates power

Power Jack ---
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To insert the netpad into the docking station, align the two devices, and press down
on the netpad until the connection is made. To eject, press down on the release
button at the top of the docking station. The netpad will be pushed up and out of the
docking station.

You can rotate the orientation of the docking station on its stand. Hold the top of the
docking station in one hand and the bottom in the other. Lift the top part to release it
and rotate through 90°. When you let go of the top part, it will click into place.

3.1.2 Multimedia Cards

Multimedia cards (MMCs) are non-volatile memory cards, which fit into a dedi-
cated slot in the netpad and can be used to store application software and/or data.

The MMC slot is located on the right hand side of the netpad.
To insert an MMC:

*  Open the card slot door located on the side of the unit by sliding the retain-
ing latch. Push the MMC into place until it clicks. Close the door.

e To remove an MMC, open the door and push the card. Store your MMC
safely, particularly if it contains valuable data.
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3.1.3 Communications Settings

When using a modem, or performing PC communications, it is necessary to define
the communication settings.

In the Link to desktop dialogue (from the Tools menu in System screen), the Link
options are: Off, Cable, or Infrared.

* Cable specifies using the RS232 communications port on the left-hand side
of the machine.

*  Docker specifies using the RS232 communications port on the right-hand
side of the docking station.

* Infrared specifies using the IR port on the back of the netpad.

_ Docking Station
Charging Contacts

For details on configuring the Modems dialogue of the Control Panel, please refer to
“Connecting The Modem (Serial)” on page 134.
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4.1 Introduction

The netpad has Infrared built in, allowing you to transfer selected information to
another netpad or other Psion Teklogix device without the use of a cable.

You can also use Infrared to print directly to printers that support Infrared - see
“Printing Using Infrared” on page 146 for more details.

4.1 Selecting Data To Transfer

On the machine from which information is to be transferred (the ‘sending
machine’), select the information you want to transfer:

* Ifthe information is a file, ensure that the file is closed and highlight the file
name on the System screen. Drag the pen if you want to transfer more than
one file.

* If the information is an object already inserted from another program, e.g. a
graph displayed in Word, just select the object. If the inserted object is dis-
played as an icon, you can just select the icon.

* If the information is an Agenda or Data entry, open the appropriate file and
move the cursor to the required entry.

* If you wish to transfer a graph, highlight the cell contents in Sheet view.
Graphs cannot be transferred direct from one Sheet file to another, only the
cell contents. Relative and absolute cell references are preserved.

* In all other cases, open the file from which the selected information is to be
transferred, and select the required information (e.g. the piece of text, range
of spreadsheet cells, sketch area).

@ Note: Objects can be transferred like other information. They appear as objects

on the receiving machine.
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4.3 Transferring The Information

1.

Ask the user of the other netpad or Psion Teklogix device to open the
program or file where the information is to be transferred fo.

L]

If the information to be transferred is an entire file, ask the other user to
tap the System icon and move to the folder to which the file is to be
transferred.

If the information is an Agenda or Data entry, ask the other user to open
the appropriate Agenda or Data file.

In all other cases, ask the other user to open the file or program to which
the selected information is to be transferred, and move the cursor to the

appropriate point in the file.

On the receiving machine, select the Infrared receive command from
the Tools menu. The Ready to receive screen is displayed.

Infrared receive

Ready to receive files

Aim the infrared machines at each other and choose send on the other one

Cancel

Position the two machines, aligning the Infrared windows (ideally, both
should be resting on the same flat surface). The Infrared window on the
netpad is on the top of the machine (see “Features Of The netpad” on
page 17). The machines should be no more than one metre apart.

On the sending machine, select the Infrared send command from the
Tools menu. If the Infrared windows are in range, the transfer begins.
Infrared screens appear on both machines to indicate that the transfer is
taking place, and the progress of the transfer is displayed.
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Infrared send

Ready to send “Report”
Looking for an infrared machine to send to

Cancel

4.3.1 When The Transfer Is Complete

When the transfer is complete the Infrared screens disappear. There is now a copy of
the selected information or file on the receiving machine.

@ Note: If afile is being transferred, and the folder on the receiving machine
already contains a file of that name, then the receiving machine displays a
dialogue where you can rename the received file, or move it to another
folder or disk drive.

The transfer does not affect the information on the sending machine.

43.2 Cancelling The Transfer

To stop the transfer while it is in progress, press Esc on either machine.

4.3.3 If The Transfer Fails

If the transfer fails, a message is displayed to indicate why. Follow the advice given
by the message and try again.
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5.1 Things To Do First

This section describes what you may need to do to set up your netpad:

L]

5.1.1

Enter owner information, so that your netpad can be returned if you lose it.

Set a passcode for your machine, so that other people cannot access
your information.

Set the current time and date, so that you can use the diary program Agenda
and set alarms.

Set your “Home city”, so that the netpad can display the correct time differ-
ences and dialling codes for other places in the World. This is useful if you
use the Time program.

Entering Owner Information

It is a good idea to type your contact information as “owner information”, so that if
you lose your netpad, it can be returned when found:

1.

Select the Passcode icon from the Control Panel in the System screen,
and tap the Owner info button in the dialogue (see “Setting A System
Passcode”, below).

Set how you wish the owner information screen to be displayed:

At switch on, if you always want to display the screen when switching
the machine on.

Once per day, if you only want to see the screen once a day, the first
time you switch your machine on each day.

Never, if you never want to display the screen when you switch on.

Type in your details and tap Done. The labels provided are suggestions
only; you can change them if you want to. It’s best not to put your home
address, in case your house keys are lost at the same time.

You can display the owner information at any time using the Owner command on
the Information menu in the System screen.
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5.1.2 Setting A System Passcode

To prevent anyone from looking at the files on the Internal disk of the netpad, set a

system passcode that you must type in before you can use the machine.

To set a system passcode:

1. Select the Passcode icon from the Control Panel in the System screen.

A %,

Time & date Sound

Screen

2 7 |

Printer Switch onfoff Applications Mods

2. Check the Ask for passcode box so that your netpad requests the pass-

code when you switch the machine on.

Passcode & owner info
Display owner info At switch on

Ask for passcode v cti+0
Clear

Enter passcode e e ol

Confirm passcode sesesesesesnse ] Cirl+C

Cancel

3. Type the passcode twice for confirmation. Choose a passcode that you
won’t easily forget, but one that won’t be easy for someone else to
guess. DON’T FORGET your passcode! You will need to enter the
passcode again if you want to change the passcode settings on
your netpad.

The passcode is now set. The next time you switch your machine on, you will have
to type in the passcode to access your files.
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If you want to switch the passcode off temporarily, remove the check from the Ask
for passcode box.

ST\ wore

The system passcode does not protect files stored on multimedia cards or
files copied to other machines.

A Important:  Don'’t forget your passcode! If you have forgotten the system pass-

5.1.3

code then you will have to reset the machine. All the files stored on
the internal disk will then be lost.

Setting The Time, Date And Home City

In the System screen, tap on Control Panel on the Toolbar, or select the
command from the Tools menu.

Tap the Time & date icon.

You see a dialogue in which you can set the time and date, your home
city and summer times around the world. Tap the Time & date button.
Move the highlight in the 7ime and Date lines by tapping on the part
you want to change, or by using the arrow keys. Type the date or time,
press P for p.m. or A for a.m.

Tap on the OK button and the time and date are saved.

Tap the Home button.

Select your Home city and country. To do this:

» Start typing in the name of your home city, or tap on the arrow symbols

or press the left and right arrow keys until you find the city you want.

* If your home city is not listed, select a city that is nearby for now
(adding a city is described in the Time document).

* Tap on the OK button and your home city is saved. Tap Close to remove
the dialogue and return to the Control Panel.

The netpad can use a 12-hour clock (midnight is 12:00:00 a.m.) or a 24-
hour clock. Refer to the “Time’ document for details on how to change
these settings, and how to adjust the clock for summer time.
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5.2 Things To Do Next

This section gives a brief overview of what else you may want to do when you first
use your netpad, including:

* Instructions for using PsiWin to connect to your PC and perform backups to
your PC.

* Ideas for customizing your netpad.

5.2.1 Connecting netpad To The PC And Using PsiWin

*  Connect the cable to the serial port on the netpad, and the other end to a
serial port at the back of the PC.

* Please see the Installing and Setting up PsiWin document for installation
instructions.

*  When you have installed PsiWin on the PC, the My Psion icon will appear
on the Windows Desktop. Just click the right mouse button on this icon to
see menu options for the things that you can do. PsiWin also adds a number
of commands and icons to Windows Explorer for working on netpad files.
For details on the use of PsiWin with the netpad, please refer to Chapter 7:
“Connecting netpad To A PC”, and also see the PsiWin online help.

@ Note: The Comms program provides terminal emulation and file transfer to
other computers. You can use it to connect the netpad directly to another
computer, or via a modem to access electronic mail systems and bulletin
boards. See the Comms User Guide for more detail.
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Backing Up To A PC

You can use PsiWin to back up individual files, folders, or the netpad’s entire disk to
the PC.

@ Note: Making regular backups.
It is a good idea to set up an “automatic backup” in PsiWin so that you

can make sure your machine is backed up regularly.

5.2.2 Backing Up To Multimedia Cards

You can back up individual files, individual folders or groups of files and folders to
a multimedia card fitted in the multimedia card (MMC) slot. To back up the files
and folders, copy them from the internal disk to a multimedia card using the Copy
and Paste commands in the System screen.

1. Select the files and folders you want to back up, then select the Copy
command from the Edit menu.

2. Set the current disk to be D (i.e. the multimedia card), and select the
folder you want to use for the backup on disk D.

3. Select the Paste command from the Edit menu.

Restoring Files From A Backup

To restore the files and folders on a multimedia card to your netpad, copy them from
the multimedia card to the Internal disk in the same way as backing up. This time,
set the current disk to D to select the files on the multimedia card, then change it to
C to paste the copied files to the Internal disk.
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5.2.3 Exploring The Control Panel

To display the Control Panel:
Move to the System screen and tap on Control Panel on the Toolbar, or select
the command from the 7ools menu.

Initially, you should set up the Time & date, Screen, Power, and Printer if you
intend to use one. You might also like to set up owner information and a passcode if
you have not done so already. You may wish to change other settings later.

*  Use the International icon to change settings that may vary from country to
country, e.g. the currency and date formats.

e Use the Power icon to control how and when the netpad switches on and
off. For example, you might like it to switch on when you tap the screen,
and off when you haven’t used it for three minutes. For details, see “Power
and Power Saving Mode” on page 57.

*  Use the Sound icon to control the sounds that the netpad makes when you
press navigation keys, tap the screen and perform other actions.

* Use the Screen icon to change the screen contrast and brightness, or
re-calibrate the touch sensitive screen if the netpad stops responding to your
pen taps.

e Use the Keyboard icon to control how long you have to hold a key down
before a repeat keypress occurs.

*  Use the Passcode icon to set a passcode on your machine or enter
owner information.
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Screen Keyboard International Textinput Addiremove
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5.2.4 Power and Power Saving Mode

1. From the Control Panel, select the Power menu.

o

Passcode

Dialling
Screen Kevboard Docker
oy
& 2 Ll
2 \ 123L5675
Printer Power Applications Scanner
| LIV INIEAN L) ID I I

2. The following menu appears. Selection of Screen tap switch on places

a checkmark in the white box. When this item is selected and the
netpad has switched off, the netpad can be restarted by tapping

the screen.

Power Management

Switch on/off |Power saving| Battery reserve

¢ Screen tap switch on[ IRl S

s Automatic switch off If no external power
creenn

oy Switch off after 00:05:00 hh:mm:ss

Printer]
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3. Selection of Automatic switch off presents the following three options.

AL S

.@ Power Management

Time & dq| Switch onfoff | Power savi
Yes
Screen tap switch on No
s Automatic switch off If no external power
creen
= Switch off after 103
&
Printer]
| TN ITI T a Ty I
* Yes

This option will automatically switch off the netpad when the time set in
the Switch off after box is reached, if there has been no user action on
the netpad for that time period.

* No
The netpad will not switch off automatically.

* If no external power
This option will automatically switch off the netpad when the time set in
the Switch off after box is reached, if there has been no user action on
the netpad for that time period, and only if there is no external power.

4. Selection of Power saving mode presents the following three options:

A . a)

Power Management

- —| Standard
Switch onfoff| Power saving Standard (no radio)
Screen Beep on screen off Vi
P Clicks when screen off v

Printer]

| LI AT I
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e Standard
This option will automatically switch off the netpad when the time set in
the Switch off after box is reached, if there has been no user action on
the netpad for that time period. (This is the same as the Yes option in
Automatic switch off).

¢ Standard (no radio)
This selection switches the netpad off in the same way as the Standard
option, but also switches off the radio, with the result that there is no
communication between the netpad and the radio. This option is used to
turn off the radio when you are entering areas where radio emissions are
not permitted, such as a plane or a hospital.

* Screen only
This mode switches off the LCD to save power, but enables the radio
unit to switch it on for an incoming transmission from the radio network.
Selection of the Screen only mode allows the user to select Beep on
screen off and Clicks when screen is off. These functions are selecting
by placing a check in the white box (see details below).

Beep on screen off

This selection will cause the unit to emit a loud beep if there has
been no user action or radio transmission when the time set in the
Switch off after option is reached.

Clicks when screen off

Once the netpad has entered the Power Saving mode by
switching off the LCD, the speaker on the netpad will click

every second to let the user know the netpad is in the LCD power
saving mode.

If Beep on screen off and Clicks when screen off are not enabled, the
netpad will switch off when the time in the Switch off after option is
reached, but there will be no sound warning that the netpad is still active.
The LCD will automatically come on with incoming transmissions to
the radio.
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To switch on the LCD with Screen only Power saving mode enabled:

i) Tap the screen if the netpad has Screen tap switch on enabled
(see page 57).

i) Press the On/Off button.
To switch off the netpad with Screen only Power saving mode enabled:

With the LCD on, pressing the On/Off button for longer that
three seconds will place the netpad into stand-by. The netpad
will not come on with incoming radio transmissions.

5.2.5 Securing Your Information

There are no known problems with passing the netpad through airport security
machines and other X-rays.

There are several things that you can do to secure your files against other hazards.
You can:

*  Make your files “read-only”. For more information see Chapter 6: “Files,
Folders, and Programs”.

*  Back up your files regularly (see “Backing Up To Multimedia Cards” on
page 55) in case they get lost or are deleted accidentally.

* Set passwords to protect information from prying eyes. You can set a pass-
word for the netpad as a whole (as explained earlier) or for individual files.
For more information see Chapter 6: “Files, Folders, and Programs”.

*  Enter contact information so that your netpad can be returned to you if you
lose it. See “Entering Owner Information” on page 51.

@ Note: It is not possible for anyone to copy information from or to your machine
using Infrared, unless they are able to access its Infrared ‘Send’ and
‘Receive’ commands.
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5.3 Customizing Your netpad

This section includes some ideas for customizing the netpad.

@ Note: You can customize the way many programs work using the Preferences
commands on the program’s Tools menu.

5.3.1 Creating Your Own Wallpaper

You can change the “wallpaper” that appears in the background on the System
screen. You can use any picture that you draw or import into Sketch.

To create wallpaper:

1. Display the picture in Sketch. If you only want to use part of a picture,
select the area.

2. Select Save as System wallpaper from the More commands on the
File menu.

3. Type a name for the wallpaper file. Sketch keeps the files that contain
wallpaper separate from the original Sketch files so you can carry on
using your original picture without affecting the wallpaper.

To select the wallpaper file to use:
Move to the System screen and select Preferences from the 7ools menu. Move
to the Wallpaper page and select the name of the wallpaper file that you want
to display.

To delete a file containing wallpaper:
Move to Sketch and select Delete System wallpaper from the More commands
on the File menu. Select the wallpaper that you want to remove.

@ Note: You cannot delete the built-in wallpaper included with the netpad.
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5.3.2 Recording Your Own Alarms

You can use the Record program to create alarm sounds that can be used in Time
and Agenda.

To save a recording for use as an alarm sound:
Select the Alarm sound button on the Toolbar or the Save as alarm sound
command from the File menu and type a name for the alarm sound. This creates
another version of the sound as an alarm, and leaves the original file open

in Record.
Record
Max

position: [T Sound length: TN wm
I (o
= Alarm
sound
- RE'wW STOP PLAY REC FFWD Goto
ZBL] fime

] (] |mmee) ] |0

~Min Home Esc Space Enter End

Volume

To delete a custom alarm sound:
Select the Delete alarm sound command from the File menu, and select the
alarm to delete from the list.

@ Note: You cannot delete or modify the built-in netpad alarm sounds.

5.3.3 Customizing The System Screen

In the System screen, you can use the commands on the View menu to change how
the System screen looks and works:

e Change the position of the Title by selecting Title position, and the width
of the columns by selecting Column width.

e Use Zoom in and Zoom out to change the size of text and icons on screen so
that more or fewer files and folders are displayed.

*  Turn the Toolbar off and on with Show foolbar; without the Toolbar you can
see more of the System screen.

*  Control how the files are sorted, and what file information is displayed with
Sort files and Show file details. When you first use the netpad, files are
grouped ‘by type’ (i.e. according to program); you can change this to sort
them by date, name or size.
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You can customize many of the ways that the netpad works from the System screen
using the Preferences command and the icons in the Control Panel. For example,
you might want to change the automatic switch off setting, owner information, the
standard printer and print preview settings, and set up a password to protect your

files from prying eyes.

You can customize the positions of icons on the Program icon bar, e.g. so that the
icons for your favourite programs appear in particular positions. To display the
Program icon bar where you can set this, press the System icon once if you are in
the System screen, or twice if you are in an application. To display the dialogue in
which you set the position of an icon, tap the title bar on the left-hand side.

Application settings

av/»

lcon position

(/ Dal

Extras bar column 1
15 Preferred program

Beside ‘Menu’ icon

Any program

Email

The System screen preferences allow you to display “hidden” files and the ‘System
folder’ in the System screen, change the standard folder for files, and change the

keypress for opening multiple files.

Warning:

The System folder contains files that are used by the netpad pro-

grams themselves. You should not normally need to access these
files, which is why this folder is not shown as standard. Do not
delete or modify files in this folder, or create new files in this folder,
otherwise you may have problems using the netpad programs.

Preferences

Files IWaIIpaper|

Show hidden files
Show ‘System’ folder

Standard folder
Open multiple files

L I
v -
Documents
Fn+Enter
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Chapter 6: Files, Folders, and Programs
Introduction

6.1 Introduction

The System screen is the netpad’s file manager. You will see the System screen the
first time you switch the netpad on; at other times, just tap the program icon. Alter-
natively, tap the open program to display the Open files/program dialogue. Then
select System and Go to file to move to it.

@ Note: When you first turn the netpad on, the name of the current folder is dis-

played in the Title at the left of the screen. If any files are present, they are
listed in columns across the screen; the icons beside their names represent
the programs that are used to open them.

Arial L|opt

. Tap program icon

Sheet C:\DocumentsiSheet

A B
1 System
2 Help
Bl Psiboard
3
4
3
L Clnseﬁlel | Done I |Gntnﬂ|e| ‘\ Help I
7
o |

Ctri+E Esc Enter N\me .
2. Select System and tap Go to file

Displaying Online Help
To display online help, select the Help option from the 7ools menu from the System
screen. This provides help on files, folders and programs.

6.2 Moving Around

To move the highlight between the files and folders on the screen:
tap on the names, or use the arrow keys. If there are more files in the folder than
can be displayed on screen, scroll the screen using the scroll bar.

You can use a “bookmark” to tag and move to a folder that you often use. Move to
the folder and select Set bookmark from the Edit menu to insert the bookmark.
Later you can select Go to bookmark from the Edit menu to move back to

the folder.
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To view the files on a multimedia card:

change the current disk by tapping the disk (C) icon in the Title bar and select
the disk you want to view, or select the command for disk D from the Current
disk command on the Disk menu.

(lose Folder Files Current Program Name

\

Memory = : 7 \ . System
Information | - {Close) BOOTLEG i People m
gl e Find
- ég AGENDA SIS @ Data @ Sales (e
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2 Apples @ direct debit @ Sheet s
=3
o i
. o ) 11
Change&(‘ 8 Asda @ expenses E} |
'6 Tue 2

6.3 Opening Files, Folders And Programs

To open a file or folder from the System screen:
tap it twice, or highlight it and press Enter. Files that are currently open have
their names displayed in bold on the System screen. Opening a file automatically
saves and closes any other file that is currently open in the associated program.

To move to a program:
tap the relevant program icon. Tap the System command icon to display the
Program icon bar with more program icons. If the program is file-based, e.g.
Data or Word, the program displays the last file you were looking at. You can
start a new file using the New file Toolbar button or the command on the File
menu (see “Creating New Files” on page 70 for more details).

@ Notes: If the last file you were looking at has been deleted, moved or renamed,
the program automatically looks for a file with a standard file name (e.g.
Word, Data, Agenda and so on) in the standard folder, and opens this file
instead. It will create a new file if necessary.

Tap on the System command icon to display icons for additional programs
installed on your netpad. If there are more programs than will fit on the
screen, tap the More button.
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How can | see which files and programs are open?

Select the List open files command on the List cascade from the File menu, or tap
the System icon. To move to a file or program in the list, highlight it and press the
Go to file button.

6.4 Closing Programs/Files

To close the current folder:
tap on the Close folder icon at the top of the screen, or highlight it and press
Enter. When you close all folders in the System screen, you move to the highest
level of the disk, called the “root” of the disk.

To close a file:
use the Close command on the File menu, either in the program in which the file
is open, or in the System screen. Any changes you have made to the file are
automatically saved.

To close a document without saving your changes:
select Revert to Saved from the program’s File menu, in the More option,
before exiting in the normal way. Some applications, like Agenda and Data,
always save your entries as you enter them, and therefore do not provide
this facility.

You can also close files or programs by selecting the list of open files and programs
by tapping the current program name, then using the Close file button in the list of
open files and programs.

6.5 Creating New Folders

You can keep a maximum of 64 items (each file or folder counts as one item) in the
“root” (top level) of the netpad’s internal disk. It’s best to create a number of folders
in which to store all your files to prevent the top level of the System screen from
becoming too full.

You might want to create some folders for work projects and others for home use.
For example, you may create a folder called “House” for files relating to work on
your house, and create another folder within the “House” folder called “Letters” for
Word files of correspondence. Using folders in this way will also make your files
easier to find.
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To create a new folder:

1. Move to the folder in which you wish to create the new folder.

2. Select the New folder command from the Toolbar or File menu, and
type in the folder name.

You cannot use the following characters in a folder name: <> : /\ *?

If you use netpad files with a PC, you may wish to create folders that match equiva-
lent folders on your PC. This will make transferring files between the netpad and
PC easier.

6.5.1 Creating New Files

You can create files from the System screen, or from within programs. As a general rule:
* Create a file from the System screen to start with the standard netpad settings.

* Create a file from within a program to use the settings that are in use in the
file currently open, e.g. labels in a Data file.

To create a file from the System screen:

1. Move to the folder where you wish to keep the file.
2. Select the Create new command from the File menu, then select File.
3. Select the program you wish to use, e.g. Word for a Word document.

4. A filename is suggested. If you do not wish to use this, type a name of
your own before pressing the OK button.

What names can | use for my files & folders?

You can use most characters in file and folder names including spaces, for example,
“1997 Purchase Orders and Invoices”. The only characters which cannot be used in
a file or folder name are / <>:\ * and ?.

The maximum length of a filename is 256 characters, although note that this
includes the disk drive letter, and the names of the folders within which the file is
contained (known as the “path”). The maximum length of a folder name, including
the path, is 252 characters.
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Generally, this will not be a problem, although it means that you may encounter dif-
ficulties if you use very long filenames for files which you store in folders which
have long names, nested within other folders with long names, and so on. If you do
exceed the maximum allowed length, rename a folder or file to a shorter name.

A Important:  Note that files are not stored with a file name extension so that an
Agenda file, e.g. called ‘1997, will have the same file name as a
Sheet file called ‘1997°. You cannot store two files with the same
name in the same folder, even if the files are created using different
programs. If you save a file with the same file name as a file already
existing in that folder, the original file will be deleted and replaced
with the new file.

= System -
& =
Create new file iﬁln\i £
[Name] Mejsting agenda =1 —
New
n Program  Word foder |
§ =} —
2 |
B 4l

6.6 Browsing Folders

A quick way to find a file is to use the Browse folders command on the File menu.
This displays a Browser which shows a tree structure of all the files and folders on
the current disk. You can also display the Browser by tapping the Title bar or press-
ing Tab in the System screen.

To move between files and folders in the Browser:
use the pen or arrow keys.

To “expand” the folder display:
highlight the folder name and tap it again or press Tab. To “collapse” the folder

display, tap the folder name twice or press Tab.

To create a folder from the Browser:
press the New folder button.

To rearrange the order of the files in the currently highlighted folder:
press the relevant Sort by button.
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To select a file from the Browser:
highlight the file and press the OK button. This selects the file in the System
screen from where you can open it, rename it, or copy, move or delete the file.

Folders Sort Files By...

Disk c/ Sort by  [4" Name] £8 Tyne| @y size |3 pate |

=l %
@ TN | @ Accounts E
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& Example file =| @ Games —
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| ixApples 21165 010101 |
= TiAsda 29275 01/01/01 | & |
¥| .BOOTLEG 2628 22/06/01 | ¥

Files

6.1 Finding Files And Folders

To search for files or folders tap the Find file button on the Toolbar or select the
command on the Edit menu.

* If you know the name or part of the name, type it on the Name line; leave it
blank to find all files and folders.

* To search only for files used with a specific program, select the program
name on the Program line; select Any to search for all files used with

any program.
* Tap OK to start the search.

This checks all files and folders on the Internal disk and includes a multimedia card
if present. The search results appear in a list.

To sort the list:
by filename, file type, file size or creation date, press the Sort button and choose
the sorting type required. To sort the list again in reverse order, just select the

same sorting type again.

To go to a file or folder:
highlight it and tap it again, or press Enter.
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6.7.1 Using Passwords

You can prevent other people from opening your Word and Sheet files by setting a
password for each file. For example, you may have a Sheet spreadsheet containing
your personal finance details. To set a password on a file:

1. Open the file and select the Password command from the File menu.

2. Type your password twice for confirmation. Choose a password that
you won'’t easily forget, but one that won’t be easy for other people
to guess.

3. Press the OK button, and the file is saved immediately with the password.
When you want to open the file, you will be asked to type in the password.

A Important:  Don'’t forget your password! If you have forgotten the password for
a file then you will not be able to open it.

The password on an individual file will protect it if you transfer it to
a multimedia card or another machine. If you copy the file, the copy
will be protected by the same password. The password also prevents
the file being converted to another format and read on a PC.

6.8 Changing File Attributes

You can prevent a file from being accidentally changed by making it a “read-only”
file. To do this, highlight the file in the System screen and select Properties from the
File menu. Then check the Read-only box.

94 Properties of file “Sheet” S
s

cil.

Last changed 12:02:20 pm 22/11/2000 panu
Size 413 Find
Fil Sheet =

ile type ee =
Read-onlyt I 2 il
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Files that have been created on a PC and then transferred to the netpad may also be
“read-only” files.

To check whether a file is a “read-only” file, highlight it in the System screen and
select Properties from the File menu.

@ Note:

If you transfer a “read-only” file to another machine, it can be viewed,
and the “read-only” attribute can be removed.

6.9 Managing Folders

To move one or more folders or files from one location to another:

1.

4

&A Notes:

First highlight the file(s) or folder(s) to select them. Drag with the pen
to select more than one file.

To select all the files/folders in the current folder, use the Select all
command on the Edit menu. To deselect items, press the Esc key.

Select the Cut (move) command from the Edit menu. A dotted line
appears round the file/folder icon(s).

Go to the disk drive and open the folder into which the highlighted
items are to be moved.

Select the Paste command from the Edit menu.

Moving a folder also moves all the files within that folder.

If you move (or rename) your most recently opened Agenda or Data file,
you should open it again by selecting it from the System screen, rather than
tapping the Agenda or Data program icon. Tapping on the program icon
will create a new Agenda or Data file.

To copy a file or folder, or multiple files/folders to a different folder:
follow the earlier instructions, but select the Copy as opposed to the Cut (move)
command from the Edit menu.
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Chapter 6: Files, Folders, and Programs
Checking Memory Use

To make a copy of a file or folder within the same folder:
highlight it on the System screen and select the Copy command followed by the
Paste command. A new file is automatically created for you using the following
naming convention (with Word as the example): Word(01), Word(02), etc. You
can rename the file or folder later if you wish.

To copy the entire contents of a disk to a folder on another disk:
e.g. to back up the entire contents of your Internal disk (C) to a backup folder on
a multimedia card (D), select Copy disk from the Disk menu.

To rename a single file or folder:
highlight it, select Rename from the File menu, and then type in a new name.

To rename a disk:
select Name disk from the Disk menu.

To remove one or more files or folders:
first highlight them and then either press the Delete key, or select the Delete
command from the File menu.

If you are deleting folders, remember that the entire contents of the
folders (including all the other folders contained within them and
all their files) will also be deleted.

6.10 Checking Memory Use

To display the amount of memory remaining:
select Show disk gauge from the View menu to see the amount of free memory
in the System screen Title bar. Tap on this gauge, or select the Disk command
from the Information menu to see more detailed information about a
selected disk.

Disk information

Disk Gauge ——» Disk A4C»
Type RAM
Size 2G

Free: 114.1M

Used 1979296K

Free 116864K

Psion Teklogix netpad EPOC User Manual

75



Chapter 6: Files, Folders, and Programs
Which Files Use The Most Memory?

76

To see information about total memory usage:
select the Memory command from the Information menu.

Memory information
Total memory 64M

| | 5%
Used 3916K
Free 61620K

6.10.1 Which Files Use The Most Memory?

Certain types of files use more memory than others.

Sound files can become very large, so you should take care to delete unwanted
Record and Voice note files so that they do not use up space on the Internal disk.

When recording a sound, the netpad will allow you to continue recording until the
‘Time available’ runs out. Even if the Time available is zero, the Record program
will always leave approximately 100 kilobytes of free memory.

If you find that the amount of free memory is suddenly reduced, it is a good idea to
check the size of any Record files.

Agenda files can also become very large. You should tidy your Agenda periodically
in order to remove entries; see the Agenda User Guide document for more details.

What will happen when the memory is full?

When the memory is nearly full, you will see warning dialogues when running pro-
grams to indicate that the netpad’s memory is almost full, and there is not enough
memory to perform some tasks.

Many of the things you do need just a little free memory in order to work—display-
ing dialogues, menus, etc. These can fail with a message like ‘Memory full’. Don’t
worry though, the netpad will not allow you to use all of the available memory; it
will always set aside enough memory for you to close a program or save an open file
to a multimedia card.

Psion Teklogix netpad EPOC User Manual



Chapter 6: Files, Folders, and Programs
Additional Memory And Programs

Files saved on the Internal disk and “open” programs both use memory. So, if the
memory is nearly full you should be able to free some memory by closing some pro-
grams. You can use the List open files command from the File menu in the System
screen to check which programs are running, and then close the programs or files
that you do not need to have open.

You can also delete any unwanted files from the System screen, or move files to a
multimedia card or your PC to free more memory.

6.10.2 Additional Memory And Programs

You can insert multimedia cards into the slot on the right-hand side of the netpad.
You might use them as additional memory for storing files, or to add more programs
to the netpad.

If a multimedia card contains additional programs:
their icons will automatically appear in the Program icon bar when you insert
the disk. They will be removed when you take out the card.

To delete all the files on a multimedia card:
put it in the slot, and then select the Format disk command from the Disk
menu; select D a s the ‘Disk’ in the Format disk dialogue.

A Important: Do not format the C disk - this will remove all the files you have
stored on the netpad’s internal disk, and remove all the preferences
and settings that you have set up.

Translated OPL programs that have not been made into applications will not appear
in the Program icon bar. If you wish to run a translated OPL program, locate the file
in the System screen, highlight the filename and tap it or press Enter to run it.

Can | run Series 3/3a/3¢/3mx/5/5mx programs on a netpad?

There are no major differences between OPL for Series 3/5 machines and OPL for
the netpad. If you have written programs in OPL on a Series 3/5, you should be able
to translate them so that you can run them on a netpad. Series 3/3a/3¢/3mx applica-
tions (which are not written as OPL programs) will not run on a netpad; however,
applications written for Series5/5mx should work but may not scale to cover the full
screen size.
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Chapter 7: Connecting netpad To A PC
Introduction

1.1 Introduction

This chapter explains how to use PsiWin to copy files between a PC and netpad, and
how to synchronize files such as Agenda, Data and Contact files. It assumes some
basic knowledge of Windows 95/98/NT4.

The chapter assumes that you have established a link between your PC and netpad.

e Check this by looking in the PC’s System tray in the bottom right-hand
corner of your desktop. There should be a wiggly line in the system tray if
you have successfully linked, as shown.

;T P ad B 1605

If this line is straight there is no connection.
| ey — 1605

*  Make sure that your link cable is connected.

*  On the netpad, go to the System screen and select Link to desktop... on the
Tools menu. Make sure that the Link line is set to Cable.

If you are having problems connecting to your netpad, please see “General Trouble-
shooting Tips” on page 167, or if docked check to make sure the RS-232 cable is
connected to the docking station.

For information about installing PsiWin, see the document, Installing and Setting
Up PsiWin. For information about printing to a PC printer via PsiWin, see “Using
PsiWin To Print Via A PC” on page 147.

1.2 About PsiWin 2

You can use the PC connectivity software, PsiWin 2, to integrate the netpad with
PCs running Windows 95/98/2000/ME or NT 4.0. By connecting the netpad to a PC
with a cable and running PsiWin on the PC, you can:

*  View your netpad files from Windows Explorer by using the ‘My Psion’
icon which is added to the PC’s Desktop. The ‘My Psion’ icon gives you
access to all of PsiWin’s powerful file management facilities for your
netpad files.
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* Drag and drop files between the netpad and the PC in the same way that
you would between PC drives, and they will be automatically converted to
the appropriate file format at the same time.

* Synchronize Agenda files and your address book on the netpad with PC
agendas (applications) and contact managers to keep them in step with
each other.

*  Back up your netpad files to the PC, then restore them from the PC to the
netpad again should you ever need to.

e Print files on your netpad to a printer connected directly to your PC, or
available to your PC via a network.

1.3 Using PsiWin

PsiWin is not a separate program; instead it allows Windows Explorer to see files on
your netpad, using the My Psion icon. You can copy your netpad files in most of the
ways you can copy any normal PC file. The two methods outlined in this chapter are
representative of ways that you might use Explorer, but are not the only possibilities.

@ Note: You can change the look of Explorer using options in the View menu;

therefore, the appearance of your own screen may vary slightly from
those shown.

14 Getting Help
1.4.1 Where Can | Find More Help?

PsiWin includes comprehensive online Help, which describes all of the application's
features and functionality. Please consult the online Help for further information or
guidance on using PsiWin.

You can display the help topics by:

e Selecting Start, then Programs, then PsiWin 2.x, then PsiWin Help.
e Selecting the My Psion icon in Explorer and pressing the F1 key.

*  Double-clicking on My Psion and selecting Help, then Help Topics from
the Menu bar.

@ Note: You can display help for a particular task or dialogue by pressing the
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<F1I> key or clicking on the Help button.

Psion Teklogix netpad EPOC User Manual



Chapter 7: Connecting netpad To A PC
Tips On Using PsiWin Help

1.4.2 Tips On Using PsiWin Help

From the Help Topics window, you can find the information you require as follows:

From the Contents page
you can select a topic from a structured list, e.g. how to perform a particular
task, or troubleshooting information about how to solve a problem. To find the
topic you want, double-click on the topic folders [I,] to find the general area
of interest, and then choose the topic you want to display.

From the Index page
you can find the topic you want by entering any word linked to the subject, such
as ‘backup’ to find topics containing information about how to back up
your netpad.

From the Find page
you can search for an exact word or phrase contained within a topic, such as
‘serial port’ to find all the topics in the online Help containing this phrase.

@ Note: To provide further assistance, help topics may also include a Related Top-
ics button _| providing links to other help topics covering similar subjects.

1.5 Working With Your Files
1.5.1 Looking At Files On Your netpad

Using My Psion and Windows Explorer, you can
open, move, copy and delete files stored on your | @
netpad from your PC. = _
. . Intemal [C:] My Psion
*  Double-click on the My Psion icon on
your Desktop. The My Psion window —
. o .
opens, displaying icons for your netpad's =
internal drive(s) and other PsiWin features
. RaMDRMNE
and settings. iM:]

*  Double-click on a drive icon to display the
files and folders on the drive.
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1.5.2 Copying A File Using Drag And Drop

1.

Open Windows Explorer:

¢ Click the Start button and select Windows Explorer from the
Programs menu.

The left-hand pane of the Explorer window shows a list of all the disk
drives on your PC, along with netpad and network drives (if any). You can
expand a branch by clicking on the |+ symbol next to it, or close the
branch by clicking on the = symbol. The right-hand side of Explorer
shows the contents of the folder selected on the left.

Use the scroll bar on the right of the left-hand Explorer pane until you can
see the drive that contains the folder that you want to copy the file to.

Using the [+ and = symbols and the scroll bar, expand the folder
list until you can see the folder that you wish to copy the file into.

Click on the folder to select it.

5‘ Exploring - C:\My Documents
File Edit ¥iew Tools Help
|AII Folders | Contents of 'C:\My Documents'
+ ] Lotapps ;I
+ ] lotus
+ (] Multimedia Files j
A
LI NAG!
+ ] notes
+-_7 Program Files
+.{71 Psion h
<] | »
U object(s) |U bytes [Disk free space: 247MEB) Y

5. Double-click on the My Psion icon y, psor 00 your Windows

File Edit Yiew Psion Help

I@ My Psion j glil E:_E'

Mo Files Psion My Psion

Archives  Backed up Synchroni... Properties

[6 obiect(s] |

I
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6. The icons to the left of the window (in this example, Internal and NO
NAME) represent disks on your netpad.

7. On your netpad browse to the
folder that contains the file you File
wish to convert to the PC. Do this
by opening the appropriate disk

icon and then the relevant C:’ C:’ Cj

folder name(s). Documents System Wwork

Edit ¥View Psion Help

IQE Internal (C:] j ﬁ

8. Open the folder. You see icons (3 obisctis)
for each of your files. The icons
correspond to the type of file.

& EPOC::C:\Work

File Edit Y¥Yiew Psion Help

[ 53 work =] & m|@|@ﬂ!§|

12 objectlz) |

x|

[

9. Rearrange the positions of the My Psion and Explorer windows until
you can see both of them at the same time.

(@] Exploring - C:\My D its =1 ]E3
File Edit VYiew Tools Help
|AII Falders | Contents of 'C:\My Documents'

+ [ Lotapps :I

+-[ lotus

+-[2] Multimedia Files -
a My Documents

. I 3 I 5 Work
0 object(s Cj

Admln Busi Comp Dist

12 ohiectls) |
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10. Click on the file you want to copy and, keeping your finger on the left
mouse button, drag the mouse pointer over the right-hand pane of the

Explorer window.

(3] Exploring - C:\My D -10][x]
File Edit ¥Yiew Tools Help
All Folders Contents of 'C:\My Docurments'
+ [ Lotapps :I
+-[] lotus \
+-[21 Multimedia Files — L
g [Evex =] ®] Fefn] 4[] X [5
0 object(: I @ @ ﬂ
Training EAdmin Agenda Business  Computer Dist
documents -
‘I object(z] selected |548 bytes 4

11. Drop the file over this area by releasing the left mouse button.

12. When the Select type of conversion... dialogue appears, select from a
list of appropriate conversion types by clicking on the ;l button.

Select type of conversion. .. n

r Erom Psion
Mame:  C:iwork\Aadmin

Type:  EPOCword

Copy Only |

~ToPC

Mame: C:Aky Documents\Admindoc

Cancel |
_per |

Help

Type: IWord for Wwindows 37

Set as Default |

13. Click the Convert button.

The file is converted into the selected PC format and can be used in the same way as

any other file on your PC.

86 Psion Teklogix netpad EPOC User Manual



Chapter 7: Connecting netpad To A PC
Copying A File Using Copy And Paste

1.5.3 Copying A File Using Copy And Paste
a

\:’
Perzonal
finances

Using Windows Explorer, you can copy files between your PC
and netpad in the same way you would copy files to a floppy
disk, or another PC on a network. PsiWin can convert files as
they are copied so that you can open them on the other com-
puter straight away.

Within Windows 95, 98 or NT4, clicking the right mouse
button often displays a context-sensitive (pop-up) menu — a
range of commands relevant to the object which you right-
click on. In Explorer, you can use these menus to copy files
between folders, regardless of whether they are on the PC or
the netpad.

1. Open Windows Explorer.

2. Navigate to, and expand, the My Psion branch of the folder list. Find

the folder

that contains the file you wish to copy to the PC and click on

it so that its contents are shown in the right-hand pane of the
Explorer window.

5'.'_ Exploring - EPOC-:C:\Work
File Edit Yiew Tools Psion Help

+
+
+

b

Al Folders | Contents of 'EPOC:C:vwork!
- ;E Internal [C:) ;I [£3 Training documents éLinux
+ .1 Documents i “h M eetin
+-[] System Open Trainil
-4 Work o Back up Unix
+ [ Training documents Usefu

g NO NAME [D:]

_| No Files Backed uo _ILI
1 >

File Archives

Create shortcut

[

1 object(s) selected

Delete

545 bytes
. Rename

RN

3. Right-click on the file and select Copy from the pop-up menu that

appears.
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Navigate to the folder you want to copy this file to, and select it, so that
its contents (if any) appear in the right-hand pane of the Explorer
window. Right-click in the right-hand pane of the Explorer window,
and select Paste from the pop-up menu.

|AII Folders | Contents of 'C: Ay Documents'
+-] Kpems d
+-[] Lotapps
+-[7] lotus - View N
+-[_1 Multimedia Files —
=3 My Documents Amange lcons  »
CIMAG Line up Icons
+-[] notes —————————
+-[771 Proaram Files hd W
LI ...........__.—I 1 Paste Shértcut
Inzerts the itemns you have copied or cutinto the selected o New 13 V]

As PsiWin copies the file, a dialogue box appears in which you can
select the type of file you wish to use on the other computer.

The dialogue suggests a suitable file type for the converted file, e.g.
Excel 5.0/95 for a netpad Sheet file, or Word 6.0/95 for a netpad Word
file. Select an alternative type if you use a different file type on your PC

Select the Convert button to copy the file from your netpad to the PC
and automatically convert it into the chosen file type.

You can select the Help button for more detailed help on the features of
this dialogue box.

You can use Windows Explorer to manage files and folders stored on your netpad in
the same way as you can on your PC’s drives.

‘%% Warning: When you delete a file on your netpad from your PC, it is perma-

nently removed from the netpad’s drive. The file cannot be retrieved
Jrom the Windows Recycle Bin, which only stores files deleted from
your PC’s drives.

Further help: See the online Help for more information on how to manage files,
folders and disks.

You can also copy the file by clicking on the file icon and dragging it to
the folder on your PC.
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1.5.4 Opening netpad Files From Your PC

You can open a file on your netpad using a PC application without first having to
copy it to your PC drive. You can edit the file on your PC and then save it back to
your netpad when you have finished.

1. To open a file from Windows Explorer, double-click on the file icon or
press Enter. A dialogue box appears in which you can select the type of
file you wish to use on your PC.

2. Select the file type suitable for the application you will use to edit the
file on your PC.

3. Click on the Convert button to copy the file and convert it to the chosen
PC file type. PsiWin opens the converted file using the PC application
associated with the file type, e.g. Paint for a Bitmap Image (*.bmp)
file, or Notepad for a Text (*.txt) file.

When you save the file within the PC application, PsiWin saves the edited file back
to your netpad. A dialogue box appears which allows you to select the file type for
the edited file. Select the appropriate file type for your netpad, and then select
Convert to copy the file back to your netpad. PsiWin makes a backup copy of the
original file, which is renamed with a ‘.bak’ suffix, e.g. a file named ‘Document’ is
backed up as ‘Document.bak’.

Important:  Don’t delete the backup version of the file from your netpad until
you are sure you want to use the edited version instead.

Further help: See the online Help for more information on how to open netpad files
on your PC.

1.6 Backing Up Your netpad With PsiWin
1.6.1 Performing Your First Backup

You can use PsiWin to back up all the files stored on your netpad to your PC.
Keeping backups of your netpad files on your PC means that you have a separate
copy of all your work that can be restored to your netpad. For example, you can
restore backed up files to your netpad if you accidentally delete a file, wish to revert
back to an older version of a file, or need to restore files if you forget to change

the batteries.
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To make a backup:
1. Double-click on the Psion Backup icon on the Desktop.
2. Inthe Psion Backup dialogue, select the drive(s) on your netpad you
wish to back up.

3. Click Back Up to start backing up the files on your netpad. PsiWin dis-
plays a progress window showing how long the backup will take and
will inform you when it has completed.

Further help: See the online Help for more information on how to back up and
restore your netpad files.

1.6.2 Scheduling Regular Backups

You can set PsiWin to make automatic backups at regular intervals so you do not
need to remember to back up your netpad. It is a good idea to schedule automatic
backups because it means you will always have up to date copies of your
netpad's files.

To schedule regular backups:
1. Right-click on My Psion and select Properties.
2. Move to the Backup tab.

3. Click on Perform automatic backup and select how often you wish to
backup your netpad.

Further help: See the online Help for more information on how to schedule regular
automatic backups.

1.1 Synchronizing Your netpad
1.1.1' What Is Synchronization?

You can use synchronization to manage information that you wish to keep up to date
on both your PC and netpad, such as agenda appointments or an address book.
When you synchronize, PsiWin checks the information in your PC scheduler with
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the matching Agenda or Data file on your netpad, and then updates the files on both
your PC and netpad to include the new information. Some examples of synchroniza-
tion are:

*  You add a new appointment in your netpad Agenda, the date, time and notes
for the entry will be copied to your PC scheduler.

*  You change a phone number in your PC scheduler; it will be amended in
your netpad’s address book.

*  You enter overlapping appointments in your PC and netpad agendas,
PsiWin will warn you of the conflict.

Many people will just use one synchronization task to keep their netpad information
in step with their PC information. Synchronization tasks can be used in a number of
other ways, for example:

*  You and other colleagues could synchronize their work Agendas with the
same master scheduler on a networked PC.

*  You may have a work Agenda synchronizing with a network installation of
Organizer at the office, and a personal Agenda synchronizing with Sched-
ule+ on your PC at home.

The following sections provide instructions for synchronizing with Microsoft Out-
look, Microsoft Schedule and Lotus Organizer.

1.1.2 Synchronizing Your netpad With Microsoft Outlook

This chapter details the set-up and day-to-day use of PsiWin to synchronize your
netpad Agenda and Data files, or the Contacts program, with Microsoft Outlook
97/98 on the PC. The chapter assumes some familiarity with the use of Windows
95/98/NT 4.0.

1121 Software Compatibility

This chapter assumes that you are using PsiWin (supplied with netpad). You must
also have a full local installation of Microsoft Outlook 97/98.
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1122 Creating New Synchronizations

If you have different Agenda or Data files, or Outlook folders that you want to syn-
chronize, you can create multiple synchronizations on your PC. You must define at
least one synchronization.

Required Information

Before creating your synchronization, note the locations of the Agenda, Data or
Contacts files you want to synchronize. The synchronization needs to know which
particular files you want to use. You must also specify which folders within Outlook
to synchronize.

* If you are synchronizing an Agenda or Data file, open the file(s) that you
want to synchronize.

*  Tap the file name at the top of the toolbar to open the Open files /programs
dialogue.

*  Scroll through the list until you find your file(s) listed.

* Make a note of the path (in this example, c:\Documents\Agenda).

Open files / programs '

Agenda C:\DocumentsiAgenda
Sketch C:ADocuments\Sketch
Mon
9 System
Sheet C:\DocumentsiSheet
Tue
10
Wed ciosefie] | pone | [Gotofie] | Hep |
ﬁ CHI+E Esc Enter Ctri+H
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1123 (Creating The Synchronization

A Important: It is very important that the following information is entered cor-
rectly — otherwise, the wrong files may be synchronized, or no syn-

chronization will occur. However, if you do not have an existing
Agenda or Database file on your netpad, the synchronizer can
create them. This is especially useful for a Contacts database — if
you specify a non-existent Data file, the synchronizer creates a new
one on the netpad that is optimized for use with your Outlook con-
tacts. The synchronization can only create a Data file if you have
select the option to synchronize a Data file.

1. Make sure that your netpad is connected to the PC.

2. Double-click on the My Psion icon. Assuming the .
machines have linked successfully, you will see several @
icons, including one labelled Psion Synchronizer. Psion

Synchroni...

3. Double-click on this icon.

4. Inthe Psion Synchronizer window, click the New button. This launches
the Psion Synchronizer Wizard, which will take you through the steps
required to set up the synchronization. If you have never created a
synchronization before, PsiWin will bypass this window and go straight
to the Synchronization Wizard.

zion Synchronizer !EI m

Sunchronize |
Lutomatic... |

Hew | Delete | Properties... | Help | Cloze |

The welcome screen of the Wizard asks you the PC PIM that you want to synchro-
nize with.
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5. Highlight the relevant option and click the Next button.

Lotuz Organizer 2.1
Lotus Organizer 37
Lotus Organizer 97 G5

Microzaft Outlook
Microzaft Schedule+ 7.0 / 7.0a

< Back Cancel | Help |

6. Inthe Psion section of the Applications dialogue, specify the netpad
files that you want to synchronize with.

a. To synchronize an Agenda file, make sure that the Synchronize My
Agenda box is checked off. Then specify the Agenda file to be synchro-
nized. Either type in the path and file name you noted earlier, or click the

_- button to browse the netpad’s disks. If in doubt, use the browse
button to find your file.

b. To synchronize a Data

file or the Contacts pro-

gram, make sure that the Use the suggested file(s), which Psiw/in can create for you if

. necessary, of browse for existing files which contain your
Synchronlze My COH- information. *r'ou may alzo need to enter your Dutlook details.
tacts box is checked off. rrEsion

¥ Synchronize My Agenda
Ic:\Work\.-’-‘n.genda |

¥ Synchionize My Contacts

IContacts program |

IF'ersonaI FalderstCalendarE xampld]
[T Use Default Calendar Folder

r Microgoft Outlook

Calendar Folder:

Taszk Folder: I
¥ Use Default T azk Folder

Cortacts Folder: I
¥ Usze Default Contacts Folder

Exchange Seftings... |

< Back I Mext» I Cancel | Help |
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program, leave the next box as
Contacts program.

To synchronize with a Data file,
click the |--| button. Select
Data and specify the Data file to
be synchronized. Either type in
the path and file name you noted
earlier or click the ... button to
browse the netpad’s disk(s). If in

Chapter 7: Connecting netpad To A PC

Choosze contacts program ﬂ

Select the Psion program you wish to uze for thiz
contacts eynchronization

€ Contacts program

& Data

File: Ic:\Documents\Dutlook Contacts |

Cancel |

doubt, use the Browse button to find your file. Next, click the

OK button.

7. Enter details for Microsoft Outlook.

To synchronize the standard Outlook folders, leave all the Use

Default... boxes checked off.

To synchronize custom Outlook folders, uncheck the relevant Use
Default... box and enter the folder path.

You can find the folder path by looking at the Folder List in Outlook. If
this isn’t shown, select Folder List from the View menu. Expand the list
until you can see the folder you want to synchronize. The path will be

the top level folder, then the subfolder that contains the folder(s) to syn-
chronize, and then the folder to synchronize. These should be separated
by backslashes (\). If the name of your top level folder contains some

text in square brackets, use this text instead of the top level folder name.

Folder Lisk

x|

--¢% Calendar
¢% Example

- @ Outlook Today - [Perzonal Folderz]
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r Microsoft Outlook

IPersonaI FoldersCalendarE sample

71 Use Default Cajendar Folder

Calendar Folder:

Tazk Folder: I
[ Use Default Tazk Folder

Contactg Folder: I
¥ Use Default Contacts Folder

Exchange Settings... I

In the example shown here, the path to the Example folder is Personal
Folders\Calendar\Example.

Enter this information into the Applications dialogue of the Synchroni-
zation wizard. Uncheck the relevant Use Default... box, in this
example, Use Default Calendar Folder, and type the path into the box
(in this example the Calendar Folder box).

8. Click on the Next button.

9. Click on the Exchange Settings... button, enter a profile name and
click the OK button if you want to synchronize with an Outlook profile
other than your PC’s default.

Exchange Settings m

Select a Profile from the list below. [f the profile vou wish to use is
nok present then type it into the box.

Chris =l
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10. The next dialogue

11.

12.

allows you to specify
which types of entry
you want to synchro-
nize. Uncheck particular
entry types if you do not
want them to be syn-
chronized.

Click the Next button
when you have selected
the entry types.

To specify the time
period to synchronize,
click the Set date
range button, select the
period required and
click the OK button.

To specify how the syn-
chronization will deal
with entries outside of
normal working hours,
select the appropriate
option from the Agenda
entries to synchronize
section. You can also
change your work hours
by clicking the Set
work hours button,
altering the settings as

Chapter 7: Connecting netpad To A PC
Synchronizing Your netpad With Microsoft Outlook

Entry Types

Select the entry types to be synchronized bebween your Psion and
PC Agendas.

r Entry types to synchronize

W Anniversaies / Annual Events
¥ Everts

I To-doz / Tazks

< Back I Ment » I
Psion To PC

r Synchronize Agenda entries
1 Month(z] in the past.

Cancel | Help |

Fram:

To b Maonth[s] in the future. Set date range;

ragenda entries to synchronize

Al specified entries

o Al specified entries, but make entries outside work. hours
private on the PC

0 Only enties within your work, hours
Daps: bon Tue wed Thu Fri

Hourz:  9:00am-5:30pm

Set work hourg

- Contacts details to synchronize

The Synchronizer will prompt you if you need to change any

contact sprichronization settings.
Advanced... |

Click Advanced to check the curment
cantact spnchronization settings.

< Back | Mest » Cancel | Help |

appropriate and clicking the OK button.
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13.

14.

15.

Click on the Advanced button to set up the label mapping. Note that if
you are synchronizing with the Contacts program, or have chosen not
to synchronize a Data file, you may not be able to click this button. In
this case, you should ignore step 14 below and click the Next button.

The Contacts Synchronization dialogue lists the labels for the Contacts
folder in Outlook (or whichever folder you have specified for contacts
information) in the Contact information column, and in the Psion label
column you can match these to their equivalents (if any) in your netpad
Data file. To match labels:

a. Find the Outlook label whose function is the same as one of your netpad

Data file’s labels, then click in the box next to it in the Psion label
column.

b. Anarrow _x| appears
to the right of this box.
Click on this to display a
drop-down list contain-
ing all the Psion labels
that you have not
matched. Select the

EE‘ Contacts Synchronization il

The ligt below shows the Qutlook, fields which you can sprchronize with
your Psion address book, and the Psion labels with which they will be
syhchronized.

If pou weant ko synchronize a Outlook field with a different Pzion label
from that which is dizplaped, click in the Psion label box next to the
appropriate Outlook fisld and gelect from the available Pgion labels.

1abel you want to assign. Contact information | Pzion label | -
Marme, last Last Mame:
c. If you do not want to Marme, first First Mame:
. : Marne, middle
synchromze with a par- Company Company:
ticular Outlook Contacts Department :
Job tithe Job Title:
label, select <Ign0re> Business address hd
: Business city <Igriore> -
from the drop—down list. Business state/province ark Tek I
| oA Nt
Each Psion label can only Home address M o';kl Fa
be matched to one Home city P° le: -]
ager:
Outlook label. E rmail -
When you have finished oK Cancel || Hep |

matching the labels, click
the OK button and then the
Next button.
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